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Overview (Customer Insights)

The Customer Insights Accelerator is one of many pre-built solutions from Pricefx that provides a
customer with a quicker path to the analysis of their pricing data.

Accelerate Sales l Accelerate

Accelerate Workflow

Accelerate Price Accelerate Price Accelerate Rebate

Integration Templates (file, SFDC, ERP — SAP, CRM — CAC, Dynamics)

Optional Accelerate e- BAIN =Promotion Accelerate Accelerate
LI VELO Value Estimati
Commerce Eircelerator ue Estimation
BAIN = . o BAIN =
B Teai Price Qptimizer e e Price Optimizer
T e Dashboard " ey Dashboard

Insights Customer Insights

PricefxPlasma

Within the design of the Pricefx PLAN/PRICE/PROFIT structure, we can see exactly where the Customer
Insights Accelerator will be included:


https://pricefx.atlassian.net/wiki/spaces/ACC/pages/4687137169
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Business Overview (Customer Insights)

Premise

You are involved with the review of customer and product analytics, and trend analysis as part of a team
from either Pricing, Financial, Sales, or IT support within your organization.

Desired Outcome

You need to prevent margin leakages through a set of actionable analytics for sales and pricing enabling
identification of customers at risk (with low health scores) and reasons behind. It includes advanced
analysis of the performance of all customers, individual customers/customer groups as well

product performance for a customer.

Context and Background

After loading the product, customer, and transactional history into Pricefx and creating a Datamart, you
are ready to start analyzing sales and pricing information for your customers and products. You need to
examine each of them to identify which ones are performing poorly and understand the reasons for this
poor performance.

Problem

You recognize that not all customers or products are providing healthy contributions to your gross margin
and you need to apply an analytics tool that will correctly identify those that are performing poorly and
clarify the root cause.

Solution Capabilities

Once this accelerator has been implemented and linked to your Datamart, then these analytical
capabilities will be available:



Ability to health score for customers and products

Provide insights on revenue and margin trends

Identify the top and bottom performing customers or products
Highlight pricing and sales opportunities

Accelerator Solution (Customer Insights)

Accelerate Customer Insights Package allows management teams to prevent margin leakages through a
set of actionable analytics for sales and pricing enabling identification of customers at risk (with low

health score) and reasons behind.

It includes advanced analysis of performance of all customers, individual customers / customer groups as
well product performance for a customer.

KPIs provided by the analysis:

® (ustomer and Product health scores
® Revenue, Margin and Volume trends
® Pricing and Sales opportunities



Dashboard Settings

Select Dashboard

Customer Insights - Customer Detail View

+ Add Portlet (15) v

Customer Insights - Customer Detail View Customer Summary
Customer: CID-0001 (Stanley Linda CPA US Global customer CA)
DATA FILTER
Segment: Global customer-Modesto
Health Score Last 12M: A+100
Customer ~ Stanley Linda CP... Q
) . Revenue Trend YTD: V+2.36% Revenue Trend (last 12M): >+29.11% Total Revenue:
Time Fiter | YTD Margin Trend YTD: V-2.73% Margin Trend (last 12M): >+31.50% Total Margin:
Category Volume Trend YTD: Vv-8.51% Volume Trend (last 12M): >+25.53% Total Volume:
Value . .
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Selling Opportunity

Universalvariance 74.80% Kirsch Tim CPA Charl

Duocon Energy CH-0049 1,907,028.51 2871% 74.80% Pricefx AG US Sold-to IL €ID-0028 8,750,905.44 1,247,075.10 9,997,980.54

Garth Corp CiD-0076

Sonntag CH-0047 1,677,015.37 25.37% 74.80% ADAM Ltd & Co CID-0050 8,750,905.44 1,244,47357 9,995,379.02

Kellermann Byton CH-0030 712,931.10 74.80% Bun cha Hudng Lién CID-0085 8,750,905.44 1,229,269.30 9,980,164.74

Customers Performance By Health Score Last 12M Customers Performance By Revenue Last 12M

Customers Performance By Revenue Last 12M

Customers Performance By Health Score Last 12M
From 2020-03-01 To 2021-02-28

From 2020-03-01 To 2021-02-28

Value Measurement (Customer Insights)

This accelerator is designed to provide an overview of the trading performance of different customer
groups through a series of dashboards. These are the measurements they provide:

® (lobal View - Provides customer performance via health score and revenue, pricing and selling

opportunity, and overall customer summary.
® Detail View - Provides a detailed customer view on revenue and margin, waterfall chart, high/low

volume products, and revenue and margin trends.
® Customer Products Portfolio - Provides pricing opportunities by product type or attribute, identifies the

top and bottom products.

Each of these different dashboards integrates our KPIs and allows you to measure them across one or
more dimensions:

Health Score

Date (Yr, Qtr, and Month)
Customer ID

Product ID

Product Class

Product Group

Product attribute

KPI Metrics (Customer Insights)

KPI stands for key performance indicator, a quantifiable measure of performance over time for a specific
objective. KPIs provide targets for teams to shoot for, milestones to gauge progress, and insights that
help people across the organization make better decisions.

KPI vs. Metrics

While key performance indicators and metrics are related, they are not the same. Here is a quick
explanation:

® Qur definition of KPlIs is the key targets you should be tracking to make the biggest impact on your
strategic business outcomes. These KPIs will support your strategy and help your teams focus on what
is important. For example, a key performance indicator could be targeted new consumers by month.



® Metrics, on the other hand, will measure the success of everyday business activities that support your
identified KPIs. While they may have an impact on your outcomes, they are not the most critical
measurements. Examples could include monthly site visits or number of modules installed.

Customer Insights KPI

As the name implies, the goal here is to examine customers and that is performed on three different
levels: global view, detailed customer view, and customer/product portfolio. The key KPIs being analyzed
are:

® Revenue

® Margin

® \/olume

® Health Score

Capabilities Summary (Customer Insights)
Out of the Box

® Global View dashboard, with charts and table reports:

Customers Performance by Health Score

Customers Performance by Revenue

Customer Health Summary

Trends

Pricing Opportunity

Selling Opportunity

Customer Summary

Inactive Customers

® Customer Detail View dashboard, with charts and table reports:

Specialty and Commodity Products

High Volume and Low Volume Products

Revenue and Margin chart

Waterfall chart

Revenue Breakdown chart

Number of Transactions in Last 12M & Projection

Customer Revenue and Margin Trend in Last 12M & Projection
Customer Summary

® Customer Products Portfolio dashboard, with charts and table reports:

Pricing Opportunity by Product Type
Pricing Opportunity by Product Attribute
Revenue and Margin Contribution
Pricing Opportunity by Top Products
Pricing Opportunity by Worst Products
Product Health Summary

Average Invoice Price

Trends

Pricing Opportunity

Selling Opportunity

Customer Summary



Configurable

® Customer Segmentation definition - You can define grouping of customers by common characteristics
/dimensions. Then selected KPIs of individual customers are calculated according to the values
aggregated on the Customer Segment level.

® Source of data - Defines from which source (Datamart / Data Source) your transactional data comes
from and which fields should be used for calculations.

® Parameters, which drive:

® (alculations of KPIs - You can set class values and thresholds for various product and customer
classifications.
® Displaying of certain things - You can change lists of options for filters, and default presets for
dashboard filters.
* Waterfall chart configuration (it uses the configuration defined for the Sales Insights accelerator
installed on the same partition)

Business User Reference (Customer Insights)

Customer Insights Dashboards consist of three separate dashboards which provide overview of trading
performance of a customer group. They also support analysis of an individual customer’s performance.

® (Global View Dashboard (Customer Insights)

® Customer Detail View Dashboard (Customer Insights)

® (Customer Products Portfolio Dashboard (Customer Insights)
® Common Aspects of Dashboards (Customer Insights)

Global View Dashboard (Customer Insights)

Global View dashboard provides customer performance via health score and revenue, pricing and selling
opportunity, and overall customer summary.

Portlets

Customer Summary

Customers Performance by Health Score Last 12M
Customers Performance by Revenue Last 12M
Customer Health Summary

Trends

Pricing Opportunity

Selling Opportunity

Inactive Customers

All of the tables/charts are based on Data Source Customer Insights Aggregated Data if not stated
otherwise.

Customer Summary
Displays some typical figures regarding a chosen customer or a group of customers.

® (ustomer displays a list of [Customer ID,(Customer Name)] following a filter group. When no customer
is selected, it is left empty.



Health Score Last 12M is re-calculated by the Trend L12M of the group.
Pricing Opportunity = ¥ Revenue below target

Selling Opportunity = ¥ Up Sell + ¥ Cross Sell

L12M trends are calculated on the monthly basis.

Note: Data are queried from Datamart.

Lrostamge S o -

Customers Performance by Health Score Last 12M

Shows relative sizes of customer classification based on Heath Score in the last 12 months.

P m—

Customers Performance by Revenue Last 12M

Shows relative sizes of customer classification based on Revenue in the last 12 months.

Customer Health Summary

Shows Customer’s Health calculated based on the difference between two periods. For example, Current
YTD and Previous YTD.
It shows correlation between Health Score and revenue, gross margin, volume.



Note: Green/red color in the Customer column does not correspond to the Health score. See how it is defin
ed.

Trends

For details on trends see Common Aspects of Dashboards (Customer Insights).

Tra=dy

Pricing Opportunity

Shows a list of customers who can be targeted to sell more products and more sales volume. The top of
the list represents the highest opportunity, these customers are under the average point in the customers
set. The bottom of the list represents the lowest opportunity. (hidden)

Friiag DRy

® Revenue below target (Evaluate purchased products)
® |f the value > O, customers have reached the revenue under the average point among the
customers set, it indicates the value that customer should obtain to reach the average base.
* |f the value = 0, customers have reached the revenue above the average point among the
customers set, they are good customers.
® % Product Buying - Shows how many products (in % ) the customer purchased in the given period.
® |f the value = 100%, the customer purchased full products set presented in the given period. It

correlates with Cross Sell Opportunity = 0.
® |f the value < 100%, the customer did not purchase the full products set presented in the given

period. It means this customer must have Cross Sell Opportunity > O.

Selling Opportunity

Shows the total value which can be gained for products that the customer already bought and not bought
in the given period.

® Cross Sell (Evaluate non-purchased products)
® The value that the customer should spend by purchasing a product which they did not buy in the

past, but other customers bought it.
® |f the value = 0, the customer bought full products set presented in the given period.

® Up Sell (Evaluate purchased products)

10



® The value that the customer should spend more by purchasing a product which they already

bought in the past.
® |f the value = 0, the customer purchased products that all are above average point in the

customers set.
® Opportunity - This is the total additional value that can be obtained for the customer, evaluate for

both purchased and non purchased products.

Fing Dpptanty

Toast Mas

Inactive Customers

This portlet shows a list of “inactive” customers so that you can identify customers which are marked as
active and for which there are no transactions in the chosen time period.
Config Inactive-Customer-classification

inscivwr Cuismees

® Applied filters: Customer(s), Time filter
® Not applied filters: Customer Rank, Customer Rank Bucket, KPI, Customer Class, Customer Health Score

® Months Inactive = Current Month - Last Active Month

Conditions Results

If PP define + No filter Get list customers PP defined that have no transaction in period
customer

If PP define + Filter customer Get list customers PP defined that have no transaction in period

If PP not define + No filter customer | Get list all customers in master have no transaction in period

If PP not define + Filter customer Get list all customers in master have no transaction in period

11
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User Inputs

DATA FILTER

Customer(s)
Time Filter *
YTD

Customer Rank *

All

Customer Rank Bucket *

5
KpI*

Health Score
Customer Class

Customer Health Score

Customer Base

To set up the dashboard, use these options:

¢ Customer(s)

* Time Filter - Possible values: MTD, QTD, YTD, L12M, L6M, L3M
® For time filters with Last Period (L3M, L6EM, L12M, ...):

® [Start date] = First month beginning date
® [End date] = Previous month end date

E.g. Today is 2021-08-06 => L3M: From 2021-05-01 to 2021-

07-31

® For time filters with up To Date (YTD, QTD, MTD, ...)
® [Start date] = Period Beginning Date

® [End date] = Current date

E.g.: Today is 2021-08-06 => QTD: From 2021-07-01 to 2021-

08-06

® Customer Rank - Possible values: All, Top, Worst

® Customer Rank Bucket - Possible values: 5,10, 50, 100

Counted items shown in the top or bottom of the list are based on the
Rank Bucket input.

If the whole list has 12 customers and Customer Rank Bucket =10,
then the top part of the list shows 10 customers and the bottom part
shows 2 customers.

Dashboard Settings

Select D:

DATA FILTER

Customer(s)  “Customer Type" e

* Time Filter | YTD

@ Customers column typically shows the top/worst aggregation of
data which is driven by inputs on the left-hand side of the dashboard.
Columns with Trends usually show increase/constant/decrease
metrics based on the Data Load calculation results. There is no direct
relation between these two types of metrics and columns.

® KPI-Possible values: Revenue, Margin %, Volume, Health Score

Customer Insights - Global View

Customer Health Summary

Customer Id

Health Score Last 12M
A +100
A +100
A 100
A +100
A +100
A +80
A +80
A +80
A +80

A +80
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Filter Rules

Portlets

Summary

Pie Chart

Table

Does not apply

Customer(s)

Customer X
Summary

Customers X
Performanc

e by Health
Score Last

12M

Customers X
Performanc

e by

Revenue
Last12M

Customer X
Health
Summary

Trends X

Pricing X
Opportunity

Selling X
Opportunity

Inactive
Customers

Customer Class - Based on cumulative contribution to the total
revenue in the last 12 months, the customer is assigned into a
category (the thresholds are configurable).

A <=20%

B <=50%

C<=95%

D = rest

Customer Health Score - Possible values: Excellent, Normal, Low,
Problematic (multiselect is enabled). For details see Common Aspects
of Dashboards (Customer Insights).

Customer Base - Based on cumulative revenue contribution and the
threshold defined, Customers are classified as either Core or Long
Tailed. For detailed formula explanation see Glossary (Customer
Insights).

® Core <=80%
® Long Tailed > 80%

User Inputs
Time Filter  Customer KPI Customer Customer Customer
Rank + Class Health Score Base
Customer
Rank Bucket
X X X X
X X X X
X X X X
X X X X X X
X X (* X X X X
X X (Ranked X X X
by Revenue
Below
Target
descending)
X X (Ranked X X X
by
Opportunity

descending)



(*): Only sorts out Customers/Products that have traded in the period, does not affect calculation results.

Customer Detail View Dashboard (Customer Insights)

Customer Detail View dashboard provides a detailed customer view on revenue and margin, waterfall
chart, high/low volume products, and revenue and margin trends.

Portlets

Customer Summary

Specialty and Commodity Products

High Volume and Low Volume Products

Revenue and Margin Chart

Waterfall Chart

Revenue Breakdown Chart

Number of Transactions in Last 12M & Projection

Customer Revenue and Margin Trend in Last 12M & Projection

Customer Summary

Displays some typical figures regarding the chosen customer.

All values are aggregated on the Customer(s) and Category levels.

If a Category value is not selected, it will be hidden in the portlet.

On click “View Customer Products Portfolio” to open new tab “Customer Products Portfolio” dashboard.
L12M trends are calculated on monthly basis.

This chart is based on Datamart.

[

Specialty and Commodity Products

Shows relative sizes of product classification based on the margin %.

Specialty products - Higher than the defined margin %
Commodity products - Lower than the defined margin %

The chart is based on Data Source Customer Insights Aggregated Data.

14
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High Volume and Low Volume Products
Shows relative sizes of product classification based on volume. The chart is based on Data Source Custome
r Insights Aggregated Data.
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Revenue and Margin Chart

Shows Revenue and Margin values over several months in the given period. The chart is based on Data
Source Customer Insights Aggregated Data.
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Waterfall Chart
Shows a running total profit as values are added or subtracted. This chart is based on Datamart. For more
details see Waterfall Dashboard.

Wwaterfall
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Revenue Breakdown Chart

Shows what the difference in revenue between two periods can be attributed to. It allows you to compare
two years or quarters and optionally filter for only certain products and/or customers. The chart is based
on Data Source Customer Insights Aggregated Data. For more details see Revenue Breakdown Dashboard

- Fields Definition.

15


https://pricefx.atlassian.net/wiki/spaces/ACC/pages/4660855304/Waterfall+Dashboard
https://pricefx.atlassian.net/wiki/spaces/ACC/pages/4660856560/Revenue+Breakdown+Dashboard+-+Fields+Definition
https://pricefx.atlassian.net/wiki/spaces/ACC/pages/4660856560/Revenue+Breakdown+Dashboard+-+Fields+Definition

Rewenue Breakodoan

IR tE L F LR Lo [ ALR ]

Number of Transactions in Last 12M & Projection

Bar & line chart shows the number of transactions for the last 12 months and estimation for the next 3
months. The current month is considered as a future month (as it has not ended yet). This chart is based

on Datamart.
nicis Teend Last § 2 & Projection

Maimber OF Tramsacnion

Customer Revenue and Margin Trend in Last 12M & Projection

Bar & line chart shows Revenue and Margin for the last 12 months and estimation for the next 3 months.
The current month is considered as a future month (as it has not ended yet). This chart is based on

Datamart.
Cusbomes Bevenue And Margin Tremd Last |28 & Projection
p ||
Al
v e g B Brormsr Fropon = Uargps % Prop s
User Inputs

To set up the dashboard, use these options:

® Customer

® Time Filter - Possible values: MTD, QTD, YTD, L12M, L6EM, L3M
® For time filters with Last Period (L3M, L6M, L12M, ...):

® [Start date] = First month beginning date

® [End date] = Previous month end date
E.g.. Today is 2021-08-06 => L3M: From 2021-05-01 to 2021-

07-31
® For time filters with up To Date (YTD, QTD, MTD, ...)

16
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DATA FILTER

Customer *

Time Filter *
YTD
Category

Value

Product Class
Product Health Score

Product Base

Filter Rules

Does not apply

Summary

Pie Chart

Bar Chart

Portlets

Customer
Summary

Specialty and
Commodity
Products

High Volume
and Low
Volume
Products

Revenue and
Margin chart

Waterfall
chart

Revenue
Breakdown
chart

Number of
Transactions
inlast12M &
Projection

Customer
Revenue and

Customer

® [Start date] = Period Beginning Date
® [End date] = Current date
E.g.: Today is 2021-08-06 => QTD: From 2021-07-01 to 2021-
08-06
Category (+ Value) - E.g.: Product ID, Product Group
Product Class - Based on cumulative contribution to the total volume
in the last 12 months, the product is assigned into a category (the
thresholds are configurable).

® Very High Volume <= 10%

® High Volume <=20%

® Normal Volume <= 75%

® Low Volume = rest

Product Health Score - Possible values: Excellent, Normal, Low,
Problematic (multiselect enabled). For details see Common Aspects of
Dashboards (Customer Insights).

Product Base - Based on cumulative revenue contribution and the
threshold defined, Products are classified as either Core or Long
Tailed. For detailed formula explanation see Glossary (Customer
Insights).

® Core <=80%
® Long Tailed > 80%

User Inputs
Time Filter Category Product Class  Product Product Base
+ Value Health Score
X X X X X
X X X X X
X X X X X
X X X X X
X X X X X
X X X X X
X X X X
X X X X



Margin Trend
inlast12M &
Projection

Classification

Commodity vs. Specialty Product

Based on average margin achieved by the product during the last 12 months (the thresholds are
configurable). For detailed formula explanation see Glossary (Customer Insights).

¢ Commodity <=40%
® Specialty > 40%

Customer Products Portfolio Dashboard (Customer Insights)

Customer Products Portfolio dashboard provides pricing opportunities by product type or attribute,
identifies the top and bottom products.

Portlets

Customer Summary

Pricing Opportunity by Product Type
Pricing Opportunity by Product Attribute
Revenue and Margin Contribution
Pricing Opportunity by Top Products
Pricing Opportunity by Worst Products
Product Health Summary

Average Invoice Price

Trends

Pricing Opportunity

Selling Opportunity

All of the tables/charts are based on Data Source Customer Insights Aggregated Data.
Customer Summary

Displays some typical figures regarding the chosen customer, showing segment that the customer
belongs to.

3. Emtoma inaghts - o Prodka 1 urrioka

=]

® L12M trends are calculated on monthly basis.
® Note in this portlet:

® Data queried from DS [Customer Insights Aggregated Data]: Trend YTD value here is the “customer
YTD [revenue/margin/quantity] trend " calculated in DS [Customer Insights Aggregated Data].

® |n Customer Detail View dashboard, data queried from Datamart: Trend YTD value will be
recalculated dynamically if the product filter is selected.



® Meanwhile in Customer Products Portfolio dashboard: The trend YTD value will not change regardless
of any product filter due to the complex calculation in this dashboard. This might be improved in the
future, like in the Customer Detail View dashboard.

Dashboard Seltings 2. Custeenor nsighis - Customer Dotnil VIEW  puubosd Settiegs 3. Curklome ieskghts - Customer Produsts Pertiolo

Pricing Opportunity by Product Type
Shows relative sizes of product classification based on the margin %.

® Specialty Products - Higher than the defined margin %
® Commodity Products - Lower than the defined margin %

Priinng Pimasing by Pt Typs i

WEILITY 1A

Pricing Opportunity by Product Attribute

Sums revenue below target by the input value in the product attribute filter. The chart label reflects the
input value in the product attribute filter.

Revenue and Margin Contribution

Shows revenue and margin split into ten buckets to visualize the number of products needed to cover
each bucket (cumulative contribution).

19
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Pricing Opportunity by Top Products

Shows products (bars) by revenue below target descending and cumulative revenue below target (line).
They are grouped by product ID.

Frking Opparhety By Top Prodenta (Ract

Pricing Opportunity By Top Praducts

Forvraus Brkow Target Crralativs Rrevrase Brlow Targes

Pricing Opportunity by Worst Products
This portlet is hidden.
Product Health Summary

Shows revenue and margin for top/worst products.

Frantit st Srasmmiry

Note: Green/red color in the Product column does not correspond to the Health score. See how it is defined.

Average Invoice Price

Shows average unit price per product ID and customer classification by revenue.

® Customer Revenue Class A/B/C/D - Average invoice price per product and customer classification.
® Overall - Average invoice price per product and all customers

20
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® Customer - Average invoice price per product and customer.

Average invoice price calculated based on data in the last 12 months. Time filter has no effect in this
table.

- g

Trends

Show trend values for top/worst products (ranked by Health Score). For details see Common Aspects of
Dashboards (Customer Insights).

Pricing Opportunity

Shows revenue below target value and % revenue below target. They are grouped by the input value in
the product attribute filter.

Selling Opportunity

Shows the total value which can be gained for products that the customer already bought and not bought
in the given period. They are grouped by the input value in the product attribute filter.

[ ——

Customer Summary

Pricing Opportunity by Product Type
Pricing Opportunity by Product Attribute
Revenue and Margin Contribution
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Product Health Summary
Average Invoice Price
Trends

Pricing Opportunity
Selling Opportunity

User Inputs

DATA FILTER

Customer *

Product Attribute *

Product Group

Time Filter *
YTD

Product Rank *

All

Product Rank Bucket *
5

Product Class

Product Health Score

Product Base

Pricing Opportunity by Top Products
Pricing Opportunity by Worst Products

To set up the dashboard, use these options:

¢ Customer
® Product Attribute - Relevant product related dimensions, by default it

is Product Group.
Time Filter - Possible values: MTD, QTD, YTD, L12M, L6M, L3M

® For time filters with Last Period (L3M, L6EM, L12M, ...):

® [Start date] = First month beginning date
® [End date] = Previous month end date
E.g. Today is 2021-08-06 => L3M: From 2021-05-01 to 2021-
07-31
® For time filters with up To Date (YTD, QTD, MTD, ...)

® [Start date] = Period Beginning Date

® [End date] = Current date
E.g.: Today is 2021-08-06 => QTD: From 2021-07-01 to 2021-
08-06

® Product Rank - Possible values: All, Top, Worst
® Product Rank Bucket - Possible values: 5, 10, 50, 100

Counted items shown in the top or bottom of the list are based on the
Rank Bucket input.

If the whole list has 12 products and Product Rank Bucket =10, then
the top part of the list shows 10 products and the bottom part shows
2 products.

Dashboard Settings Customer Insights - Global View + Add Portlet (13) ~ Export to Excel

Select D: Customer Health Summary

Health Score Last 12M

A 100
DATA FILTER N

Customer(s) | “Customer Type" e Q A +100

A +100
* Time Filter | YTD

A +100
A +80
*KPI | Health Score A +80

Gustomer Class A+80

Customer Health Score

A +80

A +80

@ Product column typically shows the top/worst aggregation of data
which is driven by inputs on the left-hand side of the dashboard.
Columns with Trends usually show increase/constant/decrease
metrics based on the Data Load calculation results. There is no direct
relation between these two types of metrics and columns.



® Product Class - Based on cumulative contribution to the total volume
in the last 12 months, the product is assigned into a category (the
thresholds are configurable).

Very High Volume <= 10%

High Volume <= 20%

Normal Volume <= 75%

Low Volume = rest

® Product Health Score - Possible values: Excellent, Normal, Low,
Problematic (multiselect enabled). For details see Common Aspects of
Dashboards (Customer Insights).

® Product Base - Based on cumulative revenue contribution and the
threshold defined, Customers and Products are classified as either
Core or Long Tailed. For detailed formula explanation see Glossary
(Customer Insights).
® Core <=80%
® Long Tailed > 80%

Filter Rules

Does not apply

Portlets User Inputs

Customer Time Filter Product Customer Product Product Product
Attribute Rank + Class Health Base
Customer Score
Rank Bucket

Summary Customer X X X X X
Summary

Pie Chart Pricing X X X X X
Opportunity
by Product

Type

Bar Chart Pricing X X X X X X
Opportunity
by Product
Attribute

Revenue X X X X X
and Margin
Contribution

Pricing X X X X X
Opportunity

by Top

Products

Pricing X X X X X X
Opportunity

by Worst

Products

Table Product X X X (by X X X
Health Health
Summary Score)

Average X X (*) X (by
Invoice Price Overall)

pad
pad
pad



Trends X X (*) X (by X X X

Health

Score)
Pricing X X X X X X X
Opportunity
Selling X X X X X X X
Opportunity

(*): Only sorts out Customers/Products that have traded in the period, does not affect calculation results.

Common Aspects of Dashboards (Customer Insights)

® (Customer Health Score, Product Health Score

® Health Score Classes
® (Customer Segmentation
® Trends Calculation
® (reate Quote from a Dashboard

Customer Health Score, Product Health Score

Customers or products are assigned into different classes based on Health Score calculated as a summary
of Revenue Health Score and Margin Health Score (with weights set for particular inputs).

The Revenue Health Score and Margin Health Score are set according to the Revenue and Margin monthly
change (trend) in the last 12 months (the maximum value is 100, the minimum value is 0) and to this
classification:

Revenue or Margin Trend Last 12M Revenue or Margin Health Score
>25% 100

15% - 25% 75

5%-15% 60

-5% - 5% 50

-5%--15% 40

-15% - -25% 25

<-25% 0

Health Score = Revenue Score * Revenue Weight + Margin Score * Margin Weight

The weight value is configurable and can be set between 0 and 1 for each (the default value is 0.5 for
each); the summary of these two has to be equal to 1 (e.g. Revenue Weight = 0,5, Margin Weight = 0,5 =>
05+05=1).

If a customer or product is decreasing in revenue and margin, the Heath Score value goes down.

Health Score Classes

® Excellent > 75

24



® Normal > 50
® Low > 25
® Problematic = rest

Customer Segmentation

To group customers by common characteristics, the Customer Segment is defined in configuration (Price
Parameters) - a list of fields the segment consists of, e.g. customer size, region, country etc.

According to values aggregated on the Customer Segment level, certain KPIs for particular customers are
calculated, e.g. cross sell.
Trends Calculation

In many portlets there are Last 12M trends of particular KPIs (for example Revenue Trend Last 12M)
presented either as such or as a part of a formula to calculate other KPls.

The trends calculation granularity (time units between which the KPI change is considered) differs per
various dashboards:

® (Clobal View: monthly
® Detail View: monthly
® Product Portfolio: quarterly

In the Customer Summary portlets these are calculated always on the monthly level.

The formulas as such are described in Glossary (CIP).

Create Quote from a Dashboard

You can create a quote from the Customer Insights - Customer Products Portfolio dashboard, specifically
from these portlets: Trends, Pricing Opportunity, and Selling Opportunity.

Dashboand Sotlings 3. Custorner Insighis - Customer Products Portfolio
Sebsct Burshioar Teends

B Fyodect M Peodusct ki

4 4 4 F B
-
4
o
=

AT P s
8 |vu
Curslorned ] .

I: Erﬁm]-lflpw:un;l'f Pricing Gippor bandy

Procect N 3 Revere
oot Pk Bt - Gl i 00008
WC-007S
- ) o
o M - -
—_— . _ _

Steps:

1. As inputs, select:
a. Customer and Time Filter which transactions exist.
b. Product Attribute = “Product Id”

2. Select a row in the result matrix.

3. Click the “Create Quote” button.
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4. A new quote is created and opened and it includes the parameters passed from the dashboard.
Quote Type is defined in the PP table “Cl_QuoteType_Mapping".
If Quote Type is not defined in PP, the quote is created with the “default” Quote Type.

Company Parameter Values: Cl Quote Type Mapping + AddRecord  Massedit  Mass delete
Dashboard Name Portlet Name Quote Type
Customerinsights_CustomerProductsPortfolio Trends __DEFAULT__
Customerinsights_CustomerProductsPortfolio Pricing Opportunity EVA
Customerinsights_CustomerProductsPortfolio Selling Opportunity CPQ

Example: Quote created from Trends, Quote Type = default (CPQ)
< P-1350 (New Quote) &  © Draft m Recalculate Export ¥ Email Quote Duplica

Header Items Attachments Workflow Messages

Items + Additems v+ AddFolder - & Detail & Settings

Label Product Id Date Added Default Inputs Color e s b 1O
Quote Type

Sausage BM MB-0029 a few seconds ago Open

¢ ¢ P (Default)

Sausage Bl MB-0030 a few seconds ago Open
Created By

Sausage PS MB-0031 a few seconds ago Open

tan

Status

Example: Quote created from Selling Opportunity, Quote Type = CPQ
< P-1351 (New Quote) & O Draft m Recalculate Export v Email Qu

Header Items Attachments Workflow Messages

Items + Additems ~  + AddFolder - & Detail & Settings
Label Product Id Date Added Default Inputs Color DEEID  Taui PR
Quote Type
NyChem 075 NC-0075 a few seconds ago Open )
Mustard mild MB-0045 a few seconds ago Open
Created By
NyChem 90 NC-0090 a few seconds ago Open
tan
Meatball BS & Mustard MB-0049 a few seconds ago Open
Status
Draft

Admin User Reference (Customer Insights)

Mandatory Data (Customer Insights)

User Roles (Customer Insights)

Deployment (Customer Insights)

Architecture Components (Customer Insights)

Mandatory Data (Customer Insights)

Type Data Fields Use Case
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Master Customer Custom attributes (optional)  ® Active/Inactive Customers identification
Data E.g. if CM.Attributel5 = “10" then the particular
customer is considered active.
® (ustomer segmentation (any other data source can
be used as well)
For example, the segment can be defined by:
¢ Country + Region

® Customer Type + Customer Group
[ ]

Product All the dimensions in the Customer Products Portfolio: Pricing and Selling
relevant Product Data Opportunities by Product Attribute:
Source (optional)
® Product Attribute defined by a user input, the filter
items are loaded from the Data Source definition.
® Used in Pricing Opportunities and Selling
Opportunities portlets as a dimension (aggregation
level).

Transacti  Sales Data

: Unique ID Core
on Data (Transactions)

Customer ID
Customer Name
Product ID
Product Name
Pricing Date
Invoice Price
(Gross) Margin
Quantity

User Roles (Customer Insights)
To use Customer Insights Package, you need to be assigned the following Pricefx user roles:

® Manage Price Lists (in the Price Setting section)
® View Company Parameters (in the Price Setting section)
® Manage PA Simulations (in Analytics section)

Deployment (Customer Insights)

Customer Insights Package is an extension of Sales Insights Package - it re-uses some Sales Insights
components.

For the correct functionality, both Sales Insights Packagel.6 and Customer Insights Package 1.6
(or later versions) have to be present at the partition.

In this section:

A. Delete Previously Created Objects

B. Run Deployment from PlatformManager

C. Update Price Parameters and Advanced Configuration Options
D. Verify Number of Threads at Partition

E. Deploy & Run Calculation Flows (Manual Step)


https://pricefx.atlassian.net/wiki/display/UNITY/User+Roles
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As the current version of PlatformManager does not support all of the steps needed to deploy the

Customer Insights Package, the step Deploy & Run Calculation Flows (Manual Step) needs to be performed
manually.

A. Delete Previously Created Objects

If you are going to run deployment to a partition where Customer Insights Package had been installed
before, it is recommended to delete the previously created objects, namely:

¢ Simulation (located in Analytics module > Simulation: Customerinsights)
® Company Parameters (main menu Company Parameters > Customerlinsights: all)

This step can be skipped if it is obvious that no changes were made to these objects (Company
Parameters structure) since the previous version (see Customer Insights Release Notes).

B. Run Deployment from PlatformManager

1. Access PlatformManager at https://platform.pricefx.com/ and log in with your account or using
0365.

2. Go to Marketplace > Accelerator Packages.
3. Find Customer Insights Package.
4

. Click Deploy.
<« c o © & nitpsy//platform.pricefx.com/#/marketplace/900/packages oo w |
pricefx platform Overview Account Marketplace 2 nw

| Accelerator Packages

Selected account
Pricefx

Accelerator Packages
Integration Templates

Accelerator packages are pre-configured solutions designed to solve specific pricing issues. With the help of Accelerator packages you can quickly
Accelerators set up a partition to a required state and allow for interaction with users (enter inputs, upload data).

Accelerator Packages

Templates Management

Customer Insights

Customer Insights

Customer Insights package for new partitions

Deploy Detail

5. Select your partition from the dropdown list and click Deploy.


https://platform.pricefx.com/

&« [ Q U & https://platform.pricefx.com/#/marketplace/800/packages e @ ﬁ I

pricefx platform Overview Account Marketplace {;T NVH

Selected account . | Accelerator Packages

Pricefx
Accelerator Packages
Integration Templates

Accelerator packages are pre-configured solutions designed to solve specific pricing issues. With the help of Accelerator packages you can quickly
Accelerators set up a partition to a required state and allow for interaction with users (enter inputs, upload data).

Accelerator Packages

Customer Insights Q
Templates Management

Customer Insights

Select partition where to deploy the Package:

| tmpl.templates-pmtest Deploy

6. Set up Datamart mapping.



Customer Insights

Datamart Mapping
Customer Insights Package (CIP) is an extension of Sales Insights Package (SIP) - re-uses some of its components. For the correct

functionality either the latest version of both SIP and CIP or at least versions mentioned in Customer Insights Dashboard
Deployment guide (or later ones) have to be present at the partition.

Source Type *

Datamart

Datamart Name

Standard_Sales_Data

Datamart Customerld Field Name*

Customer Id

Datamart Customer Name Field Name *

Customer Id

Datamart Productld Field Name *

Product Id

Datamart Product Name Field Name *

Product Name

Datamart Pricing Date Field Name *

Pricing Date

Datamart Invoice Price Field Name *

Invoice Price

Datamart Margin Field Name *

Gross Margin

Datamart Quantity Field Name *

Quantity

Datamart Unique Id Field Name *

Unigue Id

Select the Datamart name and field names (from the Datamart) for mapping and click Continue.

Wait for the system to finish the import.



Customer Insights

Importing...

Deploying the predefined static logic

——— 15%

The deployment is complete.

« G o © & nhitpsy/platform.pricef.com/#/marketplace/900/packages/partition/1818/package/net pricefacceleratorsicustomer-insic *+* w o ® =

Integration Templates L]
Datamart Mapping Setup Simulation

Accelerators

Accelerator Packages congratulationsr

Templates M, t )
emplates Managemen Your Accelerator | Accelerator Package was successfully deployed. Continue to see the result.

Go to partition

C. Update Price Parameters and Advanced Configuration Options

The PFXTemplate_Customerinsights_Customer_Segment Company Parameter needs to be consistent
with the partition data for the fields set as Active. This CP defines the fields used for a customer
segmentation.

If the partition has some special setting (different from the Accelerator default setting), check and update
the settings in other Company Parameters.

For more details see Configuration (CIP).
D. Verify Number of Threads at Partition

Starting with Customer Insights Package version 1.6, it is recommended to have 8 threads per partition
where Customer Insights is deployed. If the number is lower, Data Load calculations may fail.

By default, the value is lower, so you need to check with Pricefx Support. Threads are set by them as a
server config parameter nunber O Thr eadsPer Par ti ti on for both paQuer y and paDat aLoad.
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E. Deploy & Run Calculation Flows (Manual Step)

To keep the aggregated data (CI_AggregatedData Data Source) synchronized with customer classification
data (Cl_CustomerClassification Data Source), a scheduled job needs to be set to run the Data Load
Cl_CustomerClassification first and then run Cl_AggregatedData Data Load (Distributed Calculation).

This can be done in Calculation Flows by taking these steps:

1. Go to Administration > Configuration > Calculation Flows.
2. Find a calculation flow with the name “CustomerInsights_Sequencer”.

pril:e!x Administration / Configuration / System Configuration / Calculation Flows

System Configuration Calculation Flows
General Settings
Flows + Add & C Flow Items
Internationalization
Name Draft Name Periodic Next Run Date

Home Page
Customerinsights_Sequ

Bound Partitions

Advanced Configuration Options
My Workflows

Entitlements

| Calculation Flows

Analytics
Analytics General Settings

Analytics to Price Setting Mapping

General Chart Settings

eploy

Integration Tags

Work Status Options -

| (® Customerinsights_Sequencer Sequence v 26/08/2021 8:41

Time Unit

+ Add

Number of Time Units

3. Select the “Customerlnsights_Sequencer” and update Time Unit and Number of Time Units.
You define here how often the data will be refreshed and when. This setting has a big impact on
the dashboard results and their validity.

@

Logic Nan

rice, Administration |/ Configuration / System Configuration | Calculation Flows
g i g

System Configuration Calculation Flows
General Settings

Flows +Aadd & O Flow Items
Internationalization

Name Draft Name Periodic Next Run Date
Home Page
Customerlinsights_Sequ

Bound Partitions

(® Customerinsights Sequencer Sequence v 26/08/2021 8:41
Advanced Configuration Options
My Workflows
Entitlements

Calculation Flows

Analytics
Analytics General Settings
Analytics to Price Setting Mapping

General Chart Settings

eploy

Integration Tags
1 row 1 row
Work Status Options -

4. Click the Deploy button to deploy the calculation flow.
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Administration / Configuration / System Configuration / Calculation Flows

System Configuration

General Settings
Internationalization

Home Page

Bound Partitions

Advanced Configuration Options
My Workflows

Entitlements

Calculation Flows

Analytics
Analytics General Settings
Analytics to Price Setting Mapping

General Chart Settings

Price Setting
Integration Tags

Work Status Options

Calculation Flows

Flows +Aadd @& O Flow Items + Add @&
Name Draft Name Periodic Next Run Date Time Unit Number of Time Units  Logic Nan
CustomerInsights_Sequ
(@ Customerlnsights_Sequencer  « Sequence v Day 1 Customer
L3
1 row 1 row

5. When finished, the system will show more lines for the flows.

price,'x Administration / Configuration / System Configuration / Calculation Flows

System Configuration
General Settings
Internationalizatio

Home Page

Bound Partit

Advanced Configuration Options
My Workflows
Entitlements

Caleulation Flows

Analytics
Analytics General Settings

Analytics to Price Setting Mapping

art Settings

Price Setting

Integration Tags

tus Options

Calculation Flows

Flows + Aadd @ C Flow Items @

Name Draft Name Periodic Next Run Date Time Unit

Customerinsights_Sequ

Customerinsights_Sequences v

(® Customerlnsights_Sequence:

2 rows 1 row

6. If you want to run the calculation flow immediately, select the row in the right window and then

click Run now.



B rice, Administration / Configuration | System Configuration / Calculation Flows
g o g

System Configuration Calculation Flows

General Settings

Flows + add & C Flow Items @
Internationalization
o Name Draft Name Periodic Next Run Date Time Unit
Customerinsights_Sequ
Bound Partitions
Custome Sequencer v | Sequencer v 26/08/2021 8:41 Day
Advanced Configuration Options D oo I
My Workflows
Entitlements

Calculation Flows

Analytics

Analytics General Settings
Analytics to Price Setting Mapping
General Chart Settings

]
Price Setting

1 selected item(s) Run now Clear selection

Integration Tags |

Work Status Options -

Architecture Components (Customer Insights)

Extension

Customer Insights Package is an extension of Sales Insights Package:

® The configuration settings of waterfall chart is re-used from Sales Insights.

Advanced Configuration Option

® customer-insights-accelerator - For details see Advanced Configuration Options (Customer Insights).

Logics
Library Generic Logic
® (Customerlnsights ® (Customerlnsights_CustomerDetails
® (ustomerinsights_CustomerProductsPortfolio
PA Data Load ® Customerinsights_DimensionFilter_Configuratoi

_ . . ® Customerlnsights_GlobalView
® (Customerlnsights_Aggregation_Sim

Dashboards

® (ustomerlnsights_CustomerDetailView
® (ustomerlnsights_CustomerProductsPortfolio
® (Customerlinsights_GlobalView

Customer Parameters

® PFXTemplate_Customerinsights_Configuration - incl. sample data
® PFXTemplate_Customerinsights_Customer_Segment - incl. sample data

For details see Company Parameters (Customer Insights).
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https://pricefx.atlassian.net/wiki/display/ACC/Waterfall+Dashboard+-+Details+on+Configuration

Analytics Simulation Datamart

® (Customerlnsights

Data Sources

® (l_AggregatedData - Stores the pre-calculated data.
® (l_CustomerClassification - Stores information on customer segments and active/inactive attribute for
Customers.

Data Loads

® (l_AggregatedData - Runs a logic to fill data into Data Source CI_AggregatedData. This is Data Load of

the type Calculation+.
® (l_CustomerClassification - Runs a logic to fill data into Data Source Cl_CustomerClassification. This is

Data Load of the type Calculation.
Calculation Flow

® (ustomerlnsights_Sequencer - Keeps the data (Data Sources, Datamart) synchronized by filling the DS
Cl_CustomerClassification before the DS CI_AggregatedData is filled.

Preferences
Used for the dashboards - with layouts of the portlets.

Dependencies

This accelerator depends on the following accelerators which will be deployed during the installation too.

® Shared Library
® Dashboards Library

Technical User Reference (Customer Insights)

Company Parameters (Customer Insights)

Advanced Configuration Options (Customer Insights)
Waterfall Chart Configuration (Customer Insights)
Groovy Libraries and Logics (Customer Insights)
Data Flow (Customer Insights)

Company Parameters (Customer Insights)

Customer Insights Package works based on configuration data which users can adjust to match their
business case. These configuration data are stored in Company Parameter tables. In addition, the package
uses Company Parameters tables to define currency symbols and Quote Types.

PFXTemplate_Customerinsights_Configuration CP

Most parameters used in Customer Insights are saved in this table, including these main columns:
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Dashboard Configuration

Time Filter Selector Input

Time Filter : | YTD

MTD
QTD
¥TD
L3m
L&M
L12M

Top/Worst Customers Selector Input

TopWorst Customers :

|5

il

5
10
20
50
100

Category - Category of the configuration.
Key Name - Key name of the configuration.
Value - Defines the value corresponding to the key-set.

Is Default - If set to Yes, the dashboard will use the value of this item as a default value.
Order - Sets the order of items in the same Category.

Key Label - Defines a label shown on the chart/input.

Note - Specifies which logic type is used.

e

Data for this selector are defined in Category = “"MASTER_DATA" and Key
Name = “TIME_FILTER".

e sty Ky Mamse Vakis  [3Delal Oetled Ky Labe

TIRE_FR.TER

IT
TaE_FILTER aTh

MASTER_DATA TIME_FILTER D VES

MASTER_DATA TIME_FILTER I 4LH

MASTER_DATA TIMSE_FILTER LEM 5 LEM

MASTER_DATa TIME_FILTER LEd B L1

If you want to change the text shown in the Time Filter selector (e.g.
MTD Month To Date), you need to update the value of the column “Key
Label” from “MTD" to "“Month To Date”. If you clear the value of this

column, the Time Filter selector will show the value of the “Value” column.

Data for this selector are defined in Category = "MASTER_DATA" and Key
Name = “TOP_WORST_CUSTOMERS".

|:| Category Key Name Value IsDefauli Order™
[C] MASTER_DATA TOP_WORST_CUSTOMERS 5 YES

[C] MASTER_DATA TOP_WORST_CUSTOMERS 10

D MASTER_DATA TOP_WORST_CUSTOMERS 20

] MASTER_DATA TOP_WORST_CUSTOMERS 50

[C] MASTER_DATA TOP_WORST_CUSTOMERS 100

If you want to add more values to this list, you need add a new row with
same category and key name.

Example: To add a value “200" to the list and put it at the end of the list,
you need to add the following:

® (ategory= MASTER_DATA
® Key Name = TOP_WORST_CUSTOMER

[ B R



® Value = 200
® Order=6

Top/Worst Products Selector Input

Top/Worst Products : | 5 v‘

10
20

o [[] category

] MASTER_DATA
[] MASTER_DATA
] MASTER_DATA
] MASTER_DATA
] MASTER_DATA

KPI Selector Input

Data for this selector are defined in Category = "MASTER_DATA" and Key
: Name = “TOP_WORST_PRODUCTS".

Key Name Value IsDefault Order*

TOP_WORST_PRODUCTS 3 Y¥ES 1
TOP_WORST_PRODUCTS 10 2
TOP_WORST_PRODUCTS 20 3
TOP_WORST_PRODUCTS 20 =
TOP_WORST_PRODUCTS 100 3

Data for this selector are defined in Category = "MASTER_DATA" and Key

KPI : | Revenue v|

e Name = “KPI".

Margin%

V;Lgrlﬂne |:| Category Key Name Value lsDefault Crder Key Label

Health Score [] MASTER_DATA KPI Revenus 1 Revenue
[[] MasTER_DATA KPI Margin% 2 Margin %
[[] MasTER_DATA KPI Volume 3 Volume
|:| MASTER_DATA KPI Health Score  YES 4 Health Score

Display of Trend Columns in Table

In the tables of the
dashboard, Trend columns
are displayed with three
formats based on the
setting:

® (reenup arrow

g horizontal
arrow

® Red down arrow

Display of Health Score Columns

This column has the same
display format as the
trends columns but the
threshold is different.
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If you want to change the text shown in the KPI selector (e.g. "“Margin %"

“Margin Percent”), you need to update the value of the column “Key

Label” from “Margin %" to “Margin Percent”. If you clear the value of this
column, the KPI selector will show the value of the “Value” column.

You can define threshold values to match your business case - just
update the value of the key name “TREND_UPPER" and “TREND_LOWER":

Green and up arrow Trend value >= TREND_UPPER

TREND_LOWER < Trend value <
TREND_UPPER

Orange and horizontal arrow

Red and down arrow Trend value <= TREND_LOWER

Key Name Value IsDefault Order

TREND_UFPER 0.g
TREND_LOWER 0.3

[] | category
D COMFIGURATION
I:l COMFIGURATION

You can define it in Category = “CONFIGURATION", the key names are
"CUSTOMER_HEALTH_SCORE_UPPER" and
“CUSTOMER_HEALTH_SCORE_LOWER":

Green and up arrow



The Health Score column is Health Score >=

included in two tables: CUSTOMER_HEALTH_SCORE_UPPER
Customer Health Summary

Table (Customer Global Orange and horizontal CUSTOMER_HEALTH_SCORE_LOWER < H
View Dashboard) and arrow ealth Score <

Product Health Summary CUSTOMER_HEALTH_SCORE_UPPER
Table (Customer Product

Portfolio View Dashboard): Red and down arrow Health Score <=

CUSTOMER_HEALTH_SCORE_LOWER

7] category Key Mame Value IsDefault Order
CONFIGURATION CUSTOMER_HEALTH_SCORE_UFPPER 70
[ CONFIGURATION CUSTOMER_HEALTH_SCORE_LOWER 40

Revenue and Margin Contribution Chart (Customer Product Portfolio Dashboard)

=X

In this chart, you can re-define:

e e i i il il I * Number of buckets - via the key name = “NUMBER_OF_BUCKETS"
B T ® Percent of the start bucket / percent of the end bucket via the key
name ="BUCKET_START_PERCENT" and “BUCKET_END_PERCENT"

1 category Key Mame Value IsDefault Order  Mole
REVENUE_AND_MARGIN_CONTRIBUTION NUMBER_OF_BUCKETS 10

[T] REVENUE_AND_MARGIN_CONTRIBUTION BUCKET_START_PERGCENT 0
REVENUE_AND_MARGIN_CONTRIBUTION BUCKET_END PERCENT 100

Number of Next months (Customer Detail View Dashboard)

In the Customer Detail The default number of next months is three. You can update this value in
View dashboard, we have Category = "MASTER_DATA" and key name = “NEXT_MONTH_AMOUNT".
two charts: “Customer Category Hiey Haeot Vale | IsDefaul  Onder | Hote

MASTER_DATA HEXT_MONTH_AMCUNT 3

Revenue And Margin
Trend Last 12M &
Projection” and “Number
Of Transactions Trend Last
12M & projection”.

Customer Base, Product Base (Core Customers and Products) Selector Input

[ l Data for this selector are defined in Category = “Configuration” and Key
Name = “CUSTOMER_CORE" or “PRODUCT_CORE".

Core

Long Tailed

The value specifies the cumulative revenue thresholds for the Core vs.
Long Tailed definition.

Values range: 0..1 (e.g. 0.8 = 80%).

All
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Category * Key Mame Value

Pre-Processing (Simulation Logic) Configuration
Customer Health Score

For more details see Glossary (CIP).
Health Score = Revenue Score * Revenue Weight + Margin Score * Margin Weight
Note: Revenue Weight + Margin Weight = 1

Revenue Score / Margin Score is based on the defined table (the Trend value is the revenue/margin trend
last 12M):

1% 120

You can change the threshold trends value in the CP as shown below:

|:| Category Key Name Value IsDefault Order

|:| SCORE_CLASSIFICATION 100 0.25 1
|:| SCORE_CLASSIFICATION i) 0.15 2
[C] SCORE_CLASSIFICATION &0 0.05 3
|:| SCORE_CLASSIFICATION 30 -0.05 4
|:| SCORE_CLASSIFICATION 40 -0.1% 6
|:| SCORE_CLASSIFICATION 25 -0.25 &
[C] SCORE_CLASSIFICATION 0 -10 7

You can change the Revenue Weight and Margin Weight values in the Company Parameter.

® |f you set just the value of Revenue Weight, the system will calculate Margin Weight = (1 - Revenue
Weight) automatically.

® |f you set just the value of Margin Weight, the system will calculate Revenue Weight = (1 - Margin
Weight) automatically.

® |f you do not set either of these values, the default value is: Revenue Weight = Margin Weight = 0.5.

Customer Revenue Classification

The simulation logic uses this setting to identify the customer classification based on the contribution and
cumulative revenue contribution of each customer.

You can change the threshold value and label (show on the dashboard) in the PP as shown below:
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Customer Health Score Classification

This classification is based on the customer health score - the simulation logic assigns customers to
different classes based on Health Score.

You can change the threshold value and label (shown on the dashboard) in the PP as shown below:

Ky Hama when  Oagl e

Product Quantity Classification

The simulation logic uses this setting to identify the product classification based on the contribution and
cumulative volume contribution of each product.

You define the threshold value in this CP, for example:

Very High Volume <= 10%
High Volume <= 20%
Normal Volume <= 75%
Low Volume = rest

You must update the threshold value and label (shown on the dashboard) in the CP as shown below:

L s i my L Kozt

2 righ Eamiisen gt

Commodity vs. Specialty Product Classification

The simulation logic uses this setting to identify if a product is Commodity or Specialty Product.

It is defined based on an average margin achieved by the product.

® Speciality >= 30%
® Commodity = rest

You can update the threshold value and label (shown on the dashboard) in the CP as shown below:

Inactive Customer classification

There is an option to define the name and value of the key which identifies active Customers in Customer
Master (e.g., Customer Class = C-> active).
CP definition: category: CUSTOMER_MASTER_ACTIVE_KEY, fields: KEY_NAME, KEY_VALUE.
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PFXTemplate_Customerinsights_Customer_Segment CP

This table is used to define the customer segmentation. Customer segments can be obtained from multi
data source types such as: Data Source, Customer Master, Customer Extensions. You can define it in this
table.

You can add more customer attributes to the table if they are not present yet. Set the value of the Is
Active column to YES, if you want to add this attribute into the segmentation processing and exclude the
field with isCustomerld = YES. The field set to Is Customer Id = "YES" will not join into the segment data,
the system uses it as a key to find data.

Main columns:

® Source Type - Data Source types from which we get data for the customer segments. They include:
DMDS (Data Source), C (Customer Master), CX (Customer Extension).

Source Name - Data source name.

Source Field - Source Field in the Data Source.

Field Label - Label of the field in the Data Source.

Is Active - If set to 'YES', the dashboard will add this field in the segmentation.

Is Customer Id - If this field is customer ID in a Data Source, set the value to 'YES'. It helps the system
get the correct “Customer Id” field in the source.

If the Data Source is Customer Master or Customer Extension, you do not need to add the “customer
Id” field name.

If the Data Source is datasource, you must add the “customer Id” field name.

Note: For the field you want to be a key to find data in DMDS, you need to set IsActive = “YES" and
IsCustomerld = YES".

Example

We define that a customer segment will be obtained from the Data Source named '‘Customer’ with these
parameters:

Case 1: Segment data query from one source Case 2: Segment data query from two sources
Customer Type = active Customer Type: get from Customer Master
Region = active Region: get from DMDS “Customer”
3 Customer Types = {Enduser, Industry, : T .
Restaurant} You needvto create a configuration like th|?.
4 Regions = {America, Oceania, Asia, Europe} SumcaTps |SomeMams  |SomeFid  |Fedisbel  |hackke i Custamaria
=> We will have 3+4 = 12 Customer segments = N T
{Enduser_America, Enduser_Oceania,.....} c Custamer atrivute Customer Class
c Customer altributed Region
v = oMDS Customer Customerld YES YES

Source Type Source Mame  Source Field  Field Label IsActive  Is Customer i DMDS Customer CustomerType Customer Type

[ Customer Customer Group DMDS Customer Region Region YES

Note:

oMDS Cusiomer CustomerType Customer Type VES

oMDS Customer Region Region vES

® When querying segment data from multiple
sources, the system will take time to process
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Note: If the customer segment is queried from a (query and combine). You should consider this

Data Source, we must add the ‘customer Id’ field before processing.
name in this source and set the value to 'YES' in * If the segment data is large and complex for
the ‘Is Customer Id’ column. combination, you should create a DMDS to

build the customer segment data first, then
use it in this configuration for Customer
Insights Package.

CurrencySymbols CP

This is a Company Parameter of Sales Insights Package and it should be deployed by this package.
Customer Insights re-uses it to show the currency symbol in charts. If your currency is missing, you can
add it to this table.

Mame Value
AUD L
MNZD L3
UsSD 5
HKD 5
EUR £
JPY ¥
GEP £
CHF CHF

Cl_QuoteType_Mapping CP

This table is used to define the Quote Type on each portlet of the dashboard. When a user selects multiple
products and clicks the Create Quote button on a portlet, a new Quote with this Quote Type mapping will
be created.

Currently, we support creating a new quote from 3 portlets of the Customer Products Portfolio dashboard,
so this table has just 3 rows:

If you want to change Quote Type, you need to update the column “Quote Type" of this table from
“__DEFAULT__" to your Quote Type name.

Advanced Configuration Options (Customer Insights)

Customer Insights Package also uses the Advanced Configuration Option (AP) with the name “customer-
insights-accelerator” to store:

® Data source information
® Mapping fields

This is a template for this Advanced Configuration Option:
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customer-insights-accelerator bt

Waterfall Chart Configuration (Customer Insights)

As Customer Insights is an extension of Sales Insights, the configuration of waterfall chart is re-used from
Sales Insights. To update the waterfall configuration, follow waterfall configuration details.

Groovy Libraries and Logics (Customer Insights)

These are the main Groovy logics in this architecture:

Customerlnsights (Groovy library)

CustomerUtils

ProductUrtils

DateUtils

Configuration
CustomerGlobalDashboard
Utils

CustomerDetailDashboard
Utils

CustomerProductPortfolioD
ashboardUtils

CalculationCommonUtils
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The main library is used in the Customer Insights Dashboard logic.
It provides functions to query and process data.

Provides functions related to Customer such as:
getAllCustomerldsWithOtherAttributes,
groupByCustomerAttributes

Provides functions related to Products such as:
getProductAttributes, getSourceFieldsFromProductDataSource

Provides functions related to dates.

Reads configured data from a price parameter and advanced
configuration options.

Provides logics to process data to be shown in
Customerlnsights_GlobalView dashboards.

Provides logics to process data to be shown in
Customerlnsights_CustomerDetails dashboards.

Provides logics to process data to be shown in
Customerlnsights_CustomerProductsPortfoliodashboards.

Provides some common/calculation functions.


https://pricefx.atlassian.net/wiki/display/ACC/Waterfall+Dashboard+-+Details+on+Configuration

QueryUtils
Constant

DataTable

InputUtils

Classification

ClassificationQueryHelper

CalculationQueryHelper

SummaryPortletUtils

CustomerSegmentUtils

CommonDashboardParame
ter

GlobalViewDashboardPara
meter

DetailViewDashboardPara
meter

PortfolioDashboardParame
ter

DataloadParameter

InactiveCustomerUtils
CommonChartUtils

DataloadUtils

SharedLib

HighchartsLibrary

Provides functions to query data from the Datamart / Data Source.
Defines constants used in the Customer Insights Dashboard.

Provides functions to build the row format of the result matrix to
be displayed in the dashboard.

Provides functions to build input controls such as: Time Filter,
Category/Value...

Provides logics to pre-process data such as: calculate Customer
Health Score, Trends...

Used in dataload logic (Customerinsights_DL_Aggregation).

Provides functions to build a Query object to summarize data
from Datamart / Data Source to use in Classification.

Provides functions to build a Query object to summarize data
from Datamart / Data Source to use in Calculation.

Provides functions to create a summary data table (Summary
portlet) in dashboards.

Provides functions to query and build segment data from sources.

Defines common parameters used in the package.

Defines parameters used in the Global View dashboard, they are
inherited from Common Dashboard Parameter.

Defines parameters used in the Detail View dashboard, they are
inherited from Common Dashboard Parameter.

Defines parameters used in the Portfolio dashboard, they are
inherited from Common Dashboard Parameter.

Defines parameters used in the Data Load logic
(Customerlnsights_DL_Aggregation), they are inherited from
Common Dashboard Parameter.

Provides functions to process inactive customers.

Provides functions to process charts in dashboards.

Provides functions to process Data Loads such as: find dataload...
Groovy library to provide common functions.

Groovy library to provide functions to build Highcharts shown on
the dashboard.

Use version 1.1.2 and higher.



SIP_Dashboards_Commons Groovy library of Sales Insights, it re-uses some methods to build
a waterfall chart in a dashboard.

Customerinsights_DimensionFilter_ Configurator logic to build the Category/Value input in

Configurator dashboards.

SELECT DASHECARD

DATA FILTER
Customerlnsights_GlobalView Customer Global View dashboard logic.

Customerinsights_CustomerDetails Customer Detail View dashboard logic.

Customerinsights_CustomerProduc = Customer Product Portfolio dashboard logic.
tPortfolio

Customerlinsights_DL_Aggregation  Fills data into Data Source Cl_AggregatedData
Customerlinsights_CF_Sequencer CF logic.

Customerinsights_DS_CustomerCla Fills data into Data Source Cl_CustomerClassification.
ssification

Note: Almost all dashboard logics use SQL to have a better performance in case there are large data sets.

Data Flow (Customer Insights)

Overview
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Customer Master Diatamart

Customerinsights_DS-CustomerClassification

Customerinsights_DL_Aggregation

Data Source
Cl_CustomerClassification

Y

Data Source
Cl_AppregatedData

Customerinsights_CustomerDetails

Customerinsights_Globalview- Customerinsights_CustemerProductPortfolio

Dashboard Dashboard Dashboard
Custemer Global View Customer Detail Wiew Customer Product Porfolic

In Customer Insights Accelerator, we use Data Load to aggregate Datamart data by customer, product and
pricing month and we store it in the Data Source AggregatedData. It helps improve the dashboard
performance because:

® The system queries data in a smaller data set.
® Some data need to be pre-processed before showing on dashboards as trend values, product and

customer classification etc.

Note: There are some charts and portlets whose data are queried from the Datamart directly, not from
AggregatedData Data Source, such as:

® (Customer Global View Dashboard: Customer Summary portlet
® (Customer Detail View: Customer Summary Portlet, Waterfall chart

Aggregated Data
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customer-insights-accelerator
{Advanced Configuration}

Gustomer Id

Customer Name

Product Id

Product Name

Pricing Date

CI_AggregatedData (DataSource)

‘Gross Margin

Transaction Unique Id

G A A A

Customer Id

Customer Name

Product Id

Product Name

Pricing Date Month

Pricing Date Quarter

Pricing Date Year
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Gross Margin

Quantity

Transaction Amount

Customer Health Score

Core Customer

Customer Segment

Customer Classification By Health Score

— P

Customer Classification By Revenue

—

Customer Margin Trend

Customer Quantity Trend

—

Customer YTD Margin Trend

Customer YTD Quantity Trend

Product Health Score

Core Product

,_,_,_,,_,

Product And Customer Margin Trend

Product And Customer Quantity Trend

,_,

Product And Custemer YTD Margin Trend

Product Classification By Health Score

[ Product And Customer YTD Quantity Trend
I Product Classification By Quantity

[ Product Classification By Margin Percent

[ Product AvgPrice By Customer C

HuLuuUod

Product Overall Price:

PFXTemplate_Customerinsights_Customer_Segment
(Pricefx Parameter)

Source Type

Source Name

Source Field

Field Label

Is Active

Is Customer Id

CI_CustomerClassification
(DataSource)

Customer Master

Customer d

Customer ld

Customer Name

‘Segment

Active

i

PFXTemplate_Customerlnsights_Configuration
(Pricefx Parameter)

Category

Key Name

Value

IsDefault

Order

Key Label

Note

Customer Name



PFXTemplate_Ct ights_Ce (Pricefx )
Value is revenue/margin score

Category KeyName Value  Order
SCORE_CLASSIFICATION 100 025 1
SCORE_CLASSIFICATION 75 015 2
SCORE_CLASSIFICATION 60 05 3
SCORE_CLASSIFICATION 50 05 4
SCORE_CLASSIFICATION 40 015 5
SCORE_CLASSIFICATION 25 025 6
SCORE_CLASSIFICATION 0 -10 7

Customer Id

Customer Name

Product Id

Product Name

Pricing Date Month

Pricing Date Quarter

PFXTemplate_Ct ights_C (Pricefx )
Value is weighted factor
Category Key Name Order
CONFIGURATION REVENUE_WEIGHT | 05
CONFIGURATION MARGIN_WEIGHT | 05
PFXTemplate_Ct ights_Cq ion (Pricex )

Value is cumulative revenue coniribution of each product

Order  Key Label

CONFIGURATION PRODUCT_CORE 08

Core Customer

Customer Segment

‘Customer Classification By Health Score

Customer Revenue Trend

Customer Margin Trend

Customer Quantity Trend

Customer YTD Revenue Trend

Customer YTD Margin Trend

Customer YTD Quantity Trend

Customer Global View Dashboard

48

Core Product

Product And Customer Revenue Trend

Product And Customer Margin Trend

e
)
1
)
)
)
)

PFXTemplate_Ct ights_Ct ion (Pricefx )
Value is customer health score

Value is cumulative revenue contribtition of each customer

Order Key Label

Category Key Name Order Key
FPricing Date Year CUSTOMER_CLASSIFICATION_HEALTH_SCORE  EXCELLENT | 75 | 1 | Ecellent
Invoice Price CUSTOMER_CLASSIFICATION_HEALTH_SCORE GOOD 50 2 Good
Excellent:  Value »=75 CUSTOMER_CLASSIFICATION_HEALTH_SCORE NORMAL 25 3 Normal
Gross Margin Good: Value == 50
Normal: Value »= 25
o Vale - 25 | CUSTOMER_CLASSIFICATION_HEALTH_SCORE PROBLEMATIC | 0 | 4 | Problematic
Quantity
Transaction Amount
PFXTemplate_Ci ights_C (Pricefx )

Product And Customer YTD Margin Trend

Product And Customer YTD Quantity Trend

Product And Customer YTD Revenue Trend ]
Product Classification By ]=

Product Classification By Quanity ](——,.mm,

Product Classification By Margin Percent J]=

Product AvgPrice By Customer Classification ]

Product Overall Price ]

L
[
[
[ Product And Customer Quantity Trend
[
[
[
[
[
[
[
[
[

Product AvgPrice By Customer ]

CONFIGURATION | CUSTOMER_CORE | 0.8
PFXTemplate_Ct ights_Ce ion (Pricefx )
Value f each Custo!

A: Value <= 20%

B = 50% Category Key Name Order Key Label

C: Value <= 0%

D Value <= 100% CUSTOMER_CLASSIFICATION_REVENUE A 20 1 A
CUSTOMER_CLASSIFICATION_REVENUE B 50 2 B
CUSTOMER_CLASSIFICATION_REVENUE c 80 3 c
CUSTOMER_CLASSIFICATION_REVENUE D 100 | 4 D

PFXTemplate_Ct ights_C fion (Pricetx )
Value is product health score
Category Key Name Order Key Label
PRODUCT_CLASSIFICATION_HEALTH_SCORE EXCELLENT 75 1 Excellent
PRODUCT_CLASSIFICATION_HEALTH_SCORE GOOD 50 2 Good
PRODUCT_CLASSIFICATION_HEALTH_SCORE NORMAL 25 3 Normal
PRODUCT_CLASSIFICATION_HEALTH_SCORE =~ PROBLEMATIC 0 4 Problematic
Excellent:  Value >=75
Good. Value >= 50
Normal:  Value >= 25
Value = 25
PFXTemplate_Ct ights_C fion (Pricetx )
Value is cumulative volume contribution of each preduct
Category Key Name Order Key Label
PRODUCT_CLASSIFICATION_QUANTITY VERY_HIGH 10 1 Very High
Very High: Value <=10%
High:  Value <=20%
75% PRODUCT_CLASSIFICATION_QUANTITY HIGH 20 2 High
Low.  Value> 75%
PRODUCT_CLASSIFICATION_QUANTITY NORMAL 75 3 Normal
PRODUCT_CLASSIFICATION_QUANTITY Low 100 4 Low
Value >=30% PFXTemplate_Ct ights_C ion (Priceix )
Value < 30% Value is Margin Percent
Category Key Name Order Key Label
PRODUCT_CLASSIFICATION_MARGIN_PERCENT | SPECIALITY 30 1 Speciality
PRODUCT_CLASSIFICATION_MARGIN_PERCENT =~ COMMODITY 0 2 | Commeodity
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customer-insight-accelerator
(Advanced Configuration)

Customer Id

Customer Name

Product Id

Product Name

Pricing Date

Gross Margin

Transaction Unique Id

Customer Summary {Portlet)

Customer Health Summary (Portiet)

‘){ Customers

Customer Id

}
}

[H&'ilh Score Last 12M

Customer Name

- %

Health Score Last 12M

C1_AggregatedData (DataSource)

Total Margin

Margin Trend YTD
{ Volume Trend YTD! }

Total Volume

Customer Id

Customer Name

Product Id

Product Name

Pricing Date Quarter

Pricing Date Year

)
J
)
)

C1_CustomerClassification
(DataSource)

[ Total Margin ] [Nr of Transactions per Dav]

)

{ Total Volume J [ Margin % J
Pricing O

Pricing Opportunity (Portiet)

Customer Id

D —
o

Segment

Active

]

Customer Detail

View Dashboard

Selling Of

Inactive Customers (Portlet}

“‘5{ Customer Id

Customer Id

Customer Name

Revenue Below Target

% Revenue Below Target

Customer Name

% Products Buying

11

‘—F{ Last Active Month

Customers Performance By
Health Score Last 12M (Portlet)

Y
H

Customers Performance By
Revenue Last 12M (Portiet)

3
H

Gross Margin

Quantity

Transaction Amount

Core Customer

Customer Segment

)
}
)
Customer Health Score J
)
)
Customer Classification By Health Score J

Customer Classification By Revenue

Customer Revenue Trend

Selling Opportunity (Portiet)

Customer Id

L =

=
Opportunity

Trends (Portlet)

Customer d

Revenue Trend Last 12M

Customer Margin Trend

Margin Trend Last 12M

Customer Quantity Trend

Volume Trend Last 12M

Revenue Trend YTD

‘Customer YTD Margin Trend

Customer YTD Quantity Trend

Margin Trend YTD

Product Health Score

Core Product

Product And Customer Revenue Trend

Product And Customer Quantity Trend

Product And Customer ¥YTD Revenue Trend

Product And Customer YTD Margin Trend

[
[
[
[

Product And Customer YTD Quantity Trend

Product Classification By Health Score

Product Classification By Quantity

[

Product Classification By Margin Percent

Product AvgPrice By Customer Classification

[
[
[
[
(
[
[
[
[ Customer YTD Revenue Trend
[
[
[
[
[
[
[
[
[
[

Product Qverall Price

J
)
)
)
)
)
)
}
)
J
Product And Customer Margin Trend ]
J
)
)
J
J
)
J
]
)
J

[ Product AvgPrice By Customer

Volume Trend YTD

|




Waterfall Chart

waterfall.configuration
(Advanced Configuration)

Customer Summary (Portiet)
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Foreign Exchange Adjustmer

Local List Price.

Volume Discounts

‘Sales Channel Discounts

‘Seasonal Discounts

Customer Negotiated Discounts

Free Giveaways

Competitive Discounts

Instant Rebales

End Customer Onlnvoice Discounts

Customer Pickup Allowance

Other Oninvoice Promotions

Up Charges

Upcharge Freight

Upcharge Gustomisation

Upcharge Installation

Stocking Allowance

Early Payment Discounts

Quick Payment Discounts

Rebates

[Marketing Development Promotions

Offinvoice Promotions

Customer Loyally Program

olume Bonus

Slotting Allowance

Trade Spend

[End Customer Offinvoice Discounts

Other Offinvoice Discounts

Customization Costs

Consignment Cost

Corrections

Freight

Rush Orders

Expedited Shipping

Inventory Maintenance

Receivables Carrying

Installation Costs

‘Support Cost

Warranty

Other Transaction Costs

Raw Materials

&

B B

bor

Production

Other COGS

Customer Product Portfolio Dashboard

Customer

Segment

Health Score Last 1211

Total Margin

Total Volume

Margin Trend Last 121

Volume Trend Last 12M

Margin Trend YTD

Volume Trend YTD.

A

Calculate on .

Calculate on fly

customer-insight-accelerator
{Advanced Configuration)

Customer Id

Customer Name

Productid

Product Name

Pricing Date

Gross Margin

Transaction Unique Id

C1_AggregatedData (DataSource)

Customer Id
Customer Name
Productid
Product Name
Pricing Date Month
Pricing Date Quarter

Pricing Date Year
Gross Margin

Transaction Amount
Customer Health Score:
Gore Gustomer

Customer Segment

Customer Classification By Revenue
Customer Revenue Trend
Customer Margin Trend
Customer Quantity Trend
Customer YTD Revenue Trend
Customer YTD Margin Trend
Customer YTD Quantiy Trend
Product Health Score
Core Product
Product And Customer Revenue Trend
Product And Customer Margin Trend
Product And Customer Quantiy Trend
Product And Customer YTD Revenue Trend
Product And Customer YTD Margin Trend
Product And Customer YTD Quantity Trend

Product Classification By Health Score:

Product Classification By Margin Percent

Product Overall Price.
Product AvgPrice By Customer

4L G

Revenue Breakdown

Revenue And Margin

Customer Revenue And Margin Trend
& Projecti

m§

Nr. of Transactions Trend Last 12M &
Projection

High Volume vs Low Volume Products

Speciality vs Commodity Products

e



Customer Summary (Portlef)

Customer

Segment

Health Score Last 12M

Total Revenue

Total Margin

Total Volume

CI_AggregatedData (DataSource)

_,,{ Customer Id

Customer Name

Product Id

Pricing Date Month

Pricing Date Quarter

{
{
[
{
{

Pricing Date Year

Selling Opportunity

Product Health Summary (Portlef)

Product Id

/

Product Name

Health Score Last 12M

Margin Trend YTD

‘Gross Margin

Total Margin

Total Volume

Margin %

{hili

Quantity

Transaction Amount

-
i
E
£
%
)
&
3
=
E

Product Attribute —

i

Volume Trend YTD

Revenue And Margin Contribution Chart

|

Pricing Opportunity By Product Attribute
Name

Bar & Line Chart

Customer Health Score

Revenue Below Target

Core Customer

1

% Revenue Below Target

Customer Segment

L L

Customer Classification By Health Score

‘Customer Classification By Revenue

Customer Revenue Trend

Customer Margin Trend

Customer Quantity Trend

Pricing Opportunity By Product Rank
Chart

Bar & Line Chart

Pricing Opportunity By Product Type

Chart

H

‘Cuslomer YTD Revenue Trend

‘Customer YTD Margin Trend

cJe e JL L Je JeJgege Ju L JUL JueJe

Product Health Score ]—

Core Product

Dashboard inpul

£
2
g
:
<
?
=9
2

Product Attribute —

Cross Sell

Revenue Increase

Opportunity

1]

Trends (Portlet)

Product Id

Product Name

Product And Customer Revenue Trend

Revenue Trend Last 12M

Product And Customer Margin Trend

Margin Trend Last 12M

Volume Trend Last 12M

Product And Customer YTD Revenue Trend

Product And Customer YTD Margin Trend

Revenue Trend YTD

[
[
[

1
J
1
J
Product And Customer Quantity Trend }
1
J
)
J

Margin Trend YTD

Product And Customer YT| ty Trend ]

Product Classification By Health Score

Product Classification By Quantity

[

Product AvgPrice By Customer Classification

[
[
[
{
{
[
[
[ Customer YTD Quantity Trend
{
[
{
{
[
{
[
[

Product Overall Price

J
)
)
Product Classification By Margin Percent }
)
J
)
)

{ Product AvgPrice By Customer

Volume Trend YTD

I

Glossary (Customer Insights)

Average Invoice Price per Revenue
Class Last 12M (Portiet)

Product Id

Product Name

Overall

Customer

Class A

Class B

Class C

Class D

This glossary summarizes various terms used in Customer Insights Accelerator.

51

Term Description

Product Master

Product Id

Product Attribute 1

Product Attribute X
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Customer
Health
Score
Product
Health
Score

Customer
Classificatio
n by
Revenue

Calculated based on the fields Revenue Trend Last 12 months and Margin Trend Last 12
months.

The Revenue Health Score and Margin Health Score are set according to the Revenue
and Margin monthly or quarterly change (trend) in the last 12 months ( the maximum
value is 100, the minimum value is 0) and to this classification:

HealthScore classification.xlsx

Example:

Revenue Trend Last 12M =-19.23% => Revenue score = 25
Margin Trend Last 12M = -18.84% => Margin score = 25

Health Score = Revenue Score * Revenue Weight + Margin Score * Margin Weight

The weight value can be set (in the configuration in Price Parameters) between 0 and 1
for each (the default value is 0.5 for each); the summary of these two has to be equal to
1 (e.g. Revenue Weight = 0,5, Margin Weight=0,5=>0,5+0,5=1).

This category should be calculated based on last 12 months.

Calculation:

® (et sorted (Descending) sum of revenue per customer.

® (alculate contribution value of each customer = ¥Revenue of customer / YRevenue of
all customers

® (alculate cumulative revenue contribution per customer.

® Assigns Customers into different classes based on cumulative revenue contribution
for the last 12 months:

A<20%

B <50%

C<95%

D rest

The thresholds are configurable.

Example:
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Product
Classificatio
n by
Volume

Product
Type

A B C D E

Customer Id ~ | Invoice Price (SUM) ~ | Contribution - | Cumulative ~ | Class by revenue -
CD-00016 523,655 16.92% 16.92% A
CD-00007 522,656 16.89% 33.81%|B
CD-00026 512,354 | 16.56%|=D3+C4 C
CD-00020 512,179 16.55% 66.92% C
CD-00019 512,147 16.55% 83.46% C
CD-00015 511,736 16.54% 100.00% D

This category should be calculated based on last 12 months.

Calculation:

Get sorted (Descending) sum of volume per product
Calculate contribution value per product= ¥ Volume per product / ¥Volume per all
products

® (alculate cumulative volume contribution per product.
Assigns Products into different classes based on cumulative volume contribution for
the last 12 months:

Very High Volume < 10%
High Volume < 20%
Normal Volume £ 75%
Low Volume rest

The thresholds are configurable.

Example:

Customer Id ~ | Volume (SUM) - | Contribution ~ | Cumulative + | Class by Volume -
CD-00016 710 19.51% 19.51% |High Volume
|CD—OUOO? 650 | 17.86%| =D2+C3| Normal Volume
CD-00026 600 16.48% 53.85% Normal Volume
CD-00020 590 16.21% 70.05% Normal Volume
CD-00019 550 15.11% 85.16% Low Volume
CD-00015 540 14.84% 100.00% Low Volume

Classification whether the product belongs to Commodity or Specialty, is based on
Margin % = Margin Value / Invoice Price value (Margin field depends on your mapping
field.)

Commodity < 40%
Specialty > 40%

The thresholds are configurable in the PP table.

Make sure the value = ¥ Value of a product per all customers in the last 12 months (not
per one customer).

=> We will have only one record to for Commodity, Specialty products based on the data
for the last 12M.

When select YTD, MTD etc., the chart will sort out products that have transactions in that
period; if a product does not exist in that period of a customer, it will not count.

E.g.: We have 30 products Commodity, 70 products Specialty in the last 12M.



Cross Sell
Opportunity

Revenue
Increase

Selling
Opportunity

% Products
buying

Revenue,
Margin and
Volume
Trend Last
12 Months
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For customer X in YTD, only 50 products have transactions, 20 of them is Commodity,
the rest is Specialty, so the chart will show this accordingly.

Formula = Average (Invoice) Price per Customer Segment and per period and for Products
not bought by Customer

Example: Segment buys Product A, Product C and Product €, Customer A bought only
Product A and Product € = > cross-sell would be an average Invoice Price of Product C per
Customer Segment.

Customer Segment is defined in the configuration (Price Parameters) - a list of fields the
segment consists of.

If Quantity per Product and Customer < average Quantity per Product and per Customer
Segment, then;

Formula = (average Quantity per Product and per Customer Segment - Quantity per
Product and Customer) * average Price per Product and Customer

If Quantity per Product and Customer > average Quantity per Product and per Customer
Segment, then:

Formula: Revenue Increase = 0

Example: Customer Segment buys Product A in Average 500 quantity and Customer
bought 350 quantity, then Revenue Increase = (500 - 350) * average Price per Customer.
If Customer bought more than 500 quantity, then Revenue Increase = 0.

Customer Segment is defined in the configuration (Price Parameters) - a list of fields the
segment consists of.

= Cross Sell Opportunity + Revenue Increase

Formula = Number of Products buying in this period of a customer / Total of Products
traded in this period * 100

Example: With YTD, total 200 products are traded. Among of them, customer A buys 50
products.

% Products buying of customer Ain YTD = 50/200 * 100 = 25 %

First, the respective metric (revenue, margin or volume) is calculated for every single
time unit.

Customer level: time unit = month

Product level: time unit = quarter

Formula= ( metric for the current time unit / metric for the previous time unit ) - 1
(Periods with no data are skipped.)

Example:

® For Customer trend L12M: only months 1, 2, 5, 7, 8, 9, 10 have some data.

=> Revenue or Margin or Volume trend Month 5 = ( Revenue or Margin or VolumeMonth
5 / Revenue or Margin or VolumeMonth 2 ) -1

To get a trend value, calculate an average for dynamic months. In the example: 8
months. See the attachment for more information.
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Revenue,
Margin and
Volume
Trend YTD

Number of
Transactions

Revenue
Below
Target

% of
Revenue
below
Target

Pricing
Opportunity

Customer
Segment

Average
Invoice
Price per
Customer
Revenue

® For Product trend L12M: only quarters 1, 2, 4 have data, so we will skip quarter 3.

Trend Values xlsx

The YTD this year vs. YTD last year difference of Revenue, Margin, and Volume:

Formula = ( Revenue or Margin or Volume YTD value for the current year / Revenue or
Margin or Volume YTD value for the last year ) - 1

Total Transactions in a given period / Total days in a given period

Average Invoice Price = Average Unit Invoice Price for the particular Product ID and
particular Customer Segment

Below Average Price = the particular Unit Invoice Price - Average Unit Invoice Price
Revenue Below Target = if Below Average Price < 0 then Below Average Price * Quantity
*(-1)else 0

Formula = Revenue Below Target / Revenue

(calculated for Products with Revenue Below Target above zero)

= Revenue Below Target

To group customers by common characteristics, the Customer Segment is defined in
configuration (Company Parameters) - a list of fields the segment consists of, e.g.
customer size, region, country etc.

According to values aggregated on the Customer Segment level, certain KPIs for
particular customers are calculated, e.g. cross sell.

vt g Bvesion PTICE pev Custoemed Riviernss Clacds Last 120
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Class Last
12M

Core
Customers

Core
Products

Projected
Nr. of
Transaction
s, Margin
and
Revenue

(for the
next 3
months)

® (1) = X Invoice Price of Product / ¥ Qty of Product (per customer Last 12M)
-> In Simulation, this field is called “Product Avg Price By Customer”

® (2)=1(1)of Product of all customers in class A / Number of customers in class A
that have product Y
Do the same with class B, C, D.

® (6) Overall per product = Average { (2).(3).(4).(5) }

Core: Customers having cumulative revenue contribution in the last 12M <= 80% (or by a
PP).

Long tailed: The remaining Customers/Products having cumulative revenue contribution
in the last 12M > 80% (or by a PP).

Core: Products having cumulative revenue contribution in the last 12M <= 80% (or by a
PP).

Long tailed: The remaining Customers/Products having cumulative revenue contribution
in the last 12M > 80% (or by a PP).

® For Products this is calculated per Customer Segment (as per the Segment definition).

Projected measure for the next 3 months (calculated as adjusted linear trend based on
the first 3 months of the period).

Calculation:

® Projected measure for the particular month = linear trend for the particular month *
Seasonality Adjustment

® Seasonality Adjustment = (measure for the (particular month - 12 months) ) /
Average of the value for the last 12 months)
® |f the projected value is negative, then we return O instead.

measure = Number of Transactions, Margin or Revenue

Example of Revenue projection calculation:

Cl Revenue Proj..on_example xlsx



Release Notes (Customer Insights)

Customer Insights Dashboard 1.7
Customer Insights Dashboard 1.6
Customer Insights Dashboard 1.5
Customer Insights Dashboard 1.4
Customer Insights Dashboard 1.3
Customer Insights Dashboard 1.2
Customer Insights Dashboard 1.1
Customer Insights Dashboard 1.0

Customer Insights Dashboard 1.7
Upgrade Notes

New Company Parameter Table

This table allows users to configure Quote Type mapping for each portlet of the dashboards. When you
select multiple products and click the “Create Quote” button in the dashboard, a new Quote with the
corresponding Quote Type mapping will be created.

® Name: CI_QuoteType_Mapping
® Type: Matrix

® \/alue Type: Matrix 2

¢ Default data:

Dashboard Name Portlet Hame Guote Type

Manual Update of Logics

These logics should be added or updated:

Customerlnsights Update
Customerlnsights_ProductPortfolio Update
Customerlnsights_QuotingCreation Add

New Features and Improvements

Description ID

It is possible to create a new Quote directly from the dashboard, using products PFPCS-5913
selected in the dashboard.
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Customer Insights Dashboard 1.7.1

Bugs

PFPCS-6624 Update Cl deployment script to fix issue: removing Customer/Product data
Customer Insights Dashboard 1.7.2

This document summarizes major improvements and fixes introduced in the Accelerate Customer Insights
release version.

Version 1.7.2
Release Date Apr 5,2023
Improvements
Description ID
To allow for safe and convenient upgrades to the latest version, there is now “Customer PFPCS-
Insights Package - Upgrade” package available. 6602
Documentation has been improved based on customer feedback. PFPCS-
6628
In the Detail view, "Product Base” filter is not passed after clicking “View Customer PFPCS-
Products Portfolio”. 6643
Validation YTD value has been adjusted: PFPCS-
6645
Revenue or Margin or Revenue or Margin or Current result Expected result

Volume YTD value for the | Volume YTD value for the

current year last year

Null or 0 (any value) 0% -100%
<0 Null or 0 100% -100%
=0 Null or 0 100% 100% o
=0 Null or 0 0% %@

Customer Insights Dashboard 1.7.3

This document summarizes major improvements and fixes introduced in the Accelerate Customer Insights
Dashboard release version.

Version 1.7.3

Release Date May 22, 2023
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https://pricefx.atlassian.net/browse/PFPCS-6624

Improvements

Description

Increase all dashboard logic elements timeouts to 300.
Bugs

Description

Fix performance of Product Portfolio dashboard when loading.

Customer Insights Dashboard 1.6

Incompatibility with 1.5.0
Upgrade Notes

Bugs

Change Requests
Sub-tasks

Tasks

Incompatibility with 1.5.0

ID
PFPCS-6806

ID
PFPCS-6797

Due to changes in PFPCS-5933 the Simulation object created in 1.5.0 will not be supported in this version.

The main functionality is kept unchanged.

Upgrade Notes

Due to PFPCS-5933 there are several changes that need to happen during upgrade from 1.5.0 to 1.6.0.

The changes are:

Note: Objects contents are available here;

customer-insight...-accelerator.zip

* Add:
® Data Source:
® (l_AggregatedData
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https://pricefx.atlassian.net/browse/PFPCS-5933
https://pricefx.atlassian.net/browse/PFPCS-5933

® logics:
® (ustomerinsights_DL_Aggregation (Data Load logic)
® Data Load:

®* DMDS.CI_AggregatedData

® Update:

® (ontent of Advanced Configuration named “customer-insights-accelerator”

® logics:
Customerlnsights (Groovy library)
Customerlnsights_CF_Sequencer (CF logic)
Customerlnsights_DS_CustomerClassification (Data Load logic)
Customerlnsights_GlobalView (dashboard logic)
Customerlnsights_CustomerDetails (dashboard logic)
Customerlnsights_CustomerProductPortfolio (dashboard logic)
® Remove:

¢ Simulation: Customerinsights
® logic: Customerlnsights_Aggregation_Sim

Bugs

PFPCS-6308 Detail view: Customer summary portlet: displaying incorrectly
PFPCS-6294 Error when select filters of class

PFPCS-6274 Fix performance issue for Customer Product Portfolio dashboard

PFPCS-6254 Wrong field name of Data Source CI_AggregatedData

Change Requests

PFPCS-5933 Replace Simulation with another data source

Sub-tasks

PFPCS-6313 [Detail Dashboard] refactor api.local.xxx using to pass value to elements

PFPCS-6269 [Customer Product Portfolio] Update logics to make dashboard Customer Product Portfolio
work with new data source

PFPCS-6268 [Customer Detail] Update logics to make dashboard Customer Detail View work with new
data source

PFPCS-6184 Change/Update Calculation Flow to work with new Data Source

PFPCS-6183 [Customer Global] Update logic to make dashboard Customer Global work with new data
source

PFPCS-6182 Update package-definition

PFPCS-6181 Update Simulation logic to data load logic

PFPCS-6138 Investigate Solution Change Simulation to Data Source using Data Load logic
PFPCS-4564 [Portfolio Dashboard] refactor api.local.xxx using to pass value to elements

PFPCS-4563 [Global View Dashboard] refactor api.local.xxx using to pass value to elements

Tasks
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https://pricefx.atlassian.net/browse/PFPCS-6308
https://pricefx.atlassian.net/browse/PFPCS-6294
https://pricefx.atlassian.net/browse/PFPCS-6274
https://pricefx.atlassian.net/browse/PFPCS-6254
https://pricefx.atlassian.net/browse/PFPCS-5933
https://pricefx.atlassian.net/browse/PFPCS-6313
https://pricefx.atlassian.net/browse/PFPCS-6269
https://pricefx.atlassian.net/browse/PFPCS-6268
https://pricefx.atlassian.net/browse/PFPCS-6184
https://pricefx.atlassian.net/browse/PFPCS-6183
https://pricefx.atlassian.net/browse/PFPCS-6182
https://pricefx.atlassian.net/browse/PFPCS-6181
https://pricefx.atlassian.net/browse/PFPCS-6138
https://pricefx.atlassian.net/browse/PFPCS-4564
https://pricefx.atlassian.net/browse/PFPCS-4563

PFPCS-6271 Update logic Customerinsights_DimensionFilter_Configurator based on new structure of
Configuration

PFPCS-6265 Update DS Customer Classification logic to match with new structure Configuration
PFPCS-6251 Update structure of Configuration

PFPCS-4560 [Dashboard] refactor api.local.xxx using to pass value to elements

Customer Insights Dashboard 1.6.1

Bugs

PFPCS-6327 Data Load sometimes fails with errors. Use the api.getDatamartContext().streamQuery
(batchQuery) function instead of the api.getDatamartContext().consumeData().

Customer Insights Dashboard 1.5

Bugs
Improvements
Stories
Sub-tasks
Tasks

Bugs

PFPCS-5128 Portfolio: Customer Summary portlet; Opportunity value sum all regardless Product Rank =
Top/Worst

PFPCS-5107 Portfolio: Some portlets not show full list products when size list < Product rank bucket
PFPCS-49563 Portfolio: Selling Opportunity: fields order change per filter values

PFPCS-4811 [Customer Product Portfolio] - Missing product when Product Rank = Top

PFPCS-4809 [Portfolio]: Pricing Opportunity By Product Type Chart: not count Top/Worst list
PFPCS-4379 Trend L12M & Projection chart: missing two bars

PFPCS-4373 Inactive Customers portlet: still show customers which have transactions in time period
PFPCS-4310 Tooltips display incorrectly in some charts

PFPCS-4272 Portfolio: Customer Summary: Opportunity value always sum “all” regardless product rank
selection

PFPCS-4266 [Portfolio Dashboard] Wrong data on Pricing Opportunity By Product Rank chart

PFPCS-4231 Portfolio: Opportunity values, Revenue Below target are incorrect when select Product Class
/Health Score

PFPCS-4230 Global View: Opportunity values, Revenue Below target are incorrect when select customer
Class/Health Score

PFPCS-4216 [Portfolio Dashboard] Wrong Pricing/Selling Opportunities on Customer Summary Portlet

Improvements

61


https://pricefx.atlassian.net/browse/PFPCS-6271
https://pricefx.atlassian.net/browse/PFPCS-6265
https://pricefx.atlassian.net/browse/PFPCS-6251
https://pricefx.atlassian.net/browse/PFPCS-4560
https://pricefx.atlassian.net/browse/PFPCS-6327
https://pricefx.atlassian.net/browse/PFPCS-5128
https://pricefx.atlassian.net/browse/PFPCS-5107
https://pricefx.atlassian.net/browse/PFPCS-4963
https://pricefx.atlassian.net/browse/PFPCS-4811
https://pricefx.atlassian.net/browse/PFPCS-4809
https://pricefx.atlassian.net/browse/PFPCS-4379
https://pricefx.atlassian.net/browse/PFPCS-4373
https://pricefx.atlassian.net/browse/PFPCS-4310
https://pricefx.atlassian.net/browse/PFPCS-4272
https://pricefx.atlassian.net/browse/PFPCS-4266
https://pricefx.atlassian.net/browse/PFPCS-4231
https://pricefx.atlassian.net/browse/PFPCS-4230
https://pricefx.atlassian.net/browse/PFPCS-4216
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PFPCS-5373 Customer Product Portfolio View: Pricing Opportunity By Product Type Chart and Pricing
Opportunity By Product Attribute Chart - Update tooltip label

PFPCS-5372 Customer Product Portfolio View: Update tooltip label

PFPCS-5183 Detail View: add total volume into High Volume vs Low Volume Products portlet hint
PFPCS-4743 Detail View: Allow to override the mapped parameters with filters

PFPCS-4493 Allow drill-down in pie charts

PFPCS-4492 Allow columns sorting for all tables

PFPCS-4375 Update Customerinsights.GlobalViewDashboardParameter and Global View Dashboard logic
PFPCS-4374 Update Customerlnsights.CommonDashboardParamater

PFPCS-4198 Dashboards order in label

Stories

PFPCS-5523 Add detailedDescription to steps.json mentioning that deploying SIP is mandatory
PFPCS-5442 Data tab in chart-based portlets

PFPCS-5427 Mixpanel tracking for CIP - dashboard view

PFPCS-4119 Core Customers/Products

PFPCS-4118 Inactive Customers

PFPCS-4117 Only Top, Worst or all the Customer/Products are displayed in dashboards

Sub-tasks

PFPCS-4566 Move duplicated functions for drilldown chart in 3 dashboard to Common in library
PFPCS-4557 [Global View] Allow drill-down in pie charts

PFPCS-4555 [Product Portfolio] Allow drill-down in pie charts

PFPCS-4214 Add new inputs on Customer Product Portfolio View dashboards
PFPCS-4213 Add new inputs on Customer Detail View dashboards
PFPCS-4212 Add new inputs on Customer Global View dashboards
PFPCS-4211 Add new process for Customer Core in Simulation

PFPCS-4210 Add new process for Product Core in Simulation

PFPCS-4124 Add new inputs on Customer Products Portfolio dashboards
PFPCS-4123 Add new inputs on Customer Global View dashboard
PFPCS-4122 Change Top/Worst Customers and Top/Worst Products

Tasks

PFPCS-5617 Update Element Doc and Method docs for dashboard logics
PFPCS-5606 Hide warnings for all the portlets
PFPCS-5432 Detail View, Portfolio: Customer Input mandatory


https://pricefx.atlassian.net/browse/PFPCS-5373
https://pricefx.atlassian.net/browse/PFPCS-5372
https://pricefx.atlassian.net/browse/PFPCS-5183
https://pricefx.atlassian.net/browse/PFPCS-4743
https://pricefx.atlassian.net/browse/PFPCS-4493
https://pricefx.atlassian.net/browse/PFPCS-4492
https://pricefx.atlassian.net/browse/PFPCS-4375
https://pricefx.atlassian.net/browse/PFPCS-4374
https://pricefx.atlassian.net/browse/PFPCS-4198
https://pricefx.atlassian.net/browse/PFPCS-5523
https://pricefx.atlassian.net/browse/PFPCS-5442
https://pricefx.atlassian.net/browse/PFPCS-5427
https://pricefx.atlassian.net/browse/PFPCS-4119
https://pricefx.atlassian.net/browse/PFPCS-4118
https://pricefx.atlassian.net/browse/PFPCS-4117
https://pricefx.atlassian.net/browse/PFPCS-4566
https://pricefx.atlassian.net/browse/PFPCS-4557
https://pricefx.atlassian.net/browse/PFPCS-4555
https://pricefx.atlassian.net/browse/PFPCS-4214
https://pricefx.atlassian.net/browse/PFPCS-4213
https://pricefx.atlassian.net/browse/PFPCS-4212
https://pricefx.atlassian.net/browse/PFPCS-4211
https://pricefx.atlassian.net/browse/PFPCS-4210
https://pricefx.atlassian.net/browse/PFPCS-4124
https://pricefx.atlassian.net/browse/PFPCS-4123
https://pricefx.atlassian.net/browse/PFPCS-4122
https://pricefx.atlassian.net/browse/PFPCS-5617
https://pricefx.atlassian.net/browse/PFPCS-5606
https://pricefx.atlassian.net/browse/PFPCS-5432
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PFPCS-5431 Deployment step: Add the text noting the importance of having SIP deployed first
PFPCS-5377 Should remove date string in logic folder name

PFPCS-5206 Update document about new object in CID as: Datasource “Cl Customer Insight” and CF
PFPCS-4960 Global View: Pricing Opportunity - incorrect KPI label

PFPCS-4607 Update return structure function of CustomerSegmentUtils.getCustomerSegmenty()
PFPCS-4599 [Global View Dashboard] Update Inactive Customers Portlet

PFPCS-4598 Add CF logic to handle dataload and simulation schedule

PFPCS-4585 Cl_CustomerClassification DS

PFPCS-4569 Update Map keys in Customerlnsight.Configuration to camelCase

PFPCS-4275 [CID] Logic to get Top and Worst list with bucket to show on tables

PFPCS-4199 Reformat all code

Customer Insights Dashboard 1.5.1

Bugs

PFPCS-5718 Address the division-by-zero cases in logic

Customer Insights Dashboard 1.4

Improvements

PFPCS-3693 Add DISTINCT into SQL

PFPCS-3674 Mapped Customer parameter for Detail View

PFPCS-3669 Detail View > Revenue and Margin > No-data indication
PFPCS-3656 Summary portlets - no data indication

PFPCS-3655 Detail View - Waterfall - no-data indication

PFPCS-3628 Update Get currency of Datamart

PFPCS-3530 Customer segment PP - more effective default setting
PFPCS-3525 Update deployment script for customer insight

PFPCS-3474 Dashboards labels adjustment

PFPCS-3404 Detail View - Revenue Breakdown - no-data indication
PFPCS-3403 Create some wrapper for SummaryPortletUtils.initTableltem()
PFPCS-3350 [Simulation] Update some elements to improve performance

PFPCS-3348 [Simulation] Update cache in some elements and function to improve performance

PFPCS-3337 [Simulation] Update SQL for Customer Classification by Revenue and Product Classification

by Volume


https://pricefx.atlassian.net/browse/PFPCS-5431
https://pricefx.atlassian.net/browse/PFPCS-5377
https://pricefx.atlassian.net/browse/PFPCS-5206
https://pricefx.atlassian.net/browse/PFPCS-4960
https://pricefx.atlassian.net/browse/PFPCS-4607
https://pricefx.atlassian.net/browse/PFPCS-4599
https://pricefx.atlassian.net/browse/PFPCS-4598
https://pricefx.atlassian.net/browse/PFPCS-4585
https://pricefx.atlassian.net/browse/PFPCS-4569
https://pricefx.atlassian.net/browse/PFPCS-4275
https://pricefx.atlassian.net/browse/PFPCS-4199
https://pricefx.atlassian.net/browse/PFPCS-5718
https://pricefx.atlassian.net/browse/PFPCS-3693
https://pricefx.atlassian.net/browse/PFPCS-3674
https://pricefx.atlassian.net/browse/PFPCS-3669
https://pricefx.atlassian.net/browse/PFPCS-3656
https://pricefx.atlassian.net/browse/PFPCS-3655
https://pricefx.atlassian.net/browse/PFPCS-3628
https://pricefx.atlassian.net/browse/PFPCS-3530
https://pricefx.atlassian.net/browse/PFPCS-3525
https://pricefx.atlassian.net/browse/PFPCS-3474
https://pricefx.atlassian.net/browse/PFPCS-3404
https://pricefx.atlassian.net/browse/PFPCS-3403
https://pricefx.atlassian.net/browse/PFPCS-3350
https://pricefx.atlassian.net/browse/PFPCS-3348
https://pricefx.atlassian.net/browse/PFPCS-3337

PFPCS-3322 [Simulation] Update element GetProductAvgPriceByCustomer And
ProductAvgPriceByCustomer

PFPCS-3300 Multiple sources for Customer segment

PFPCS-3298 [CID] add into Simulation more field ProductClassificationByHealthScore.
PFPCS-3238 Charts > Add 1000 separator to displayed number

PFPCS-3203 Product Portfolio - Health Score filter

PFPCS-3202 Detail View - Health Score filter

PFPCS-3199 Global View - Health Score

PFPCS-3198 Product Portfolio - Product Class filter

PFPCS-3197 Detail View - Product Class filter

PFPCS-3196 Global View - Customer Class filter

Tasks

PFPCS-3489 [Simulation] Update parameter structure based on solution as dashboard

PFPCS-3438 Detail View - Update waterfall chart in CID because SIP_Dashboards_commons had been
changed

PFPCS-3410 [CID] typo in the element name “CustomerProductPortfolioDahboardUtils”
PFPCS-3355 Split Calculation element in Customerlnsights library into 3 sub-elements
PFPCS-3338 Detail View > Pass values in new filters to Portfolio dashboard

PFPCS-3280 [Customer Detail View] Check changes in SIP_Dashboards_commons and update for CID PFPC
S-3256 Check whether it's possible to move certain calculations to SQL

PFPCS-3177 The InputParams solution: new structure
PFPCS-3053 Redesign Customer Segment PP Table

Bugs

PFPCS-3699 Detail View > Waterfall chart display value when no data
PFPCS-3386 Total number values in tables should be integer

Customer Insights Dashboard 1.4.5

Bugs
PFPCS-4284 [Simulation] wrong calculation of YTD Trends

Customer Insights Dashboard 1.3
Bugs
® [PFPCS-3003] - Hotfix- Portfolio_ Average invoice price table

® [PFPCS-3086] - [Detail View]> Chart > Nr. of Transaction trend last 12M& projection: Number of
transactions is incorrect
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https://pricefx.atlassian.net/browse/PFPCS-3322
https://pricefx.atlassian.net/browse/PFPCS-3300
https://pricefx.atlassian.net/browse/PFPCS-3298
https://pricefx.atlassian.net/browse/PFPCS-3238
https://pricefx.atlassian.net/browse/PFPCS-3203
https://pricefx.atlassian.net/browse/PFPCS-3202
https://pricefx.atlassian.net/browse/PFPCS-3199
https://pricefx.atlassian.net/browse/PFPCS-3198
https://pricefx.atlassian.net/browse/PFPCS-3197
https://pricefx.atlassian.net/browse/PFPCS-3196
https://pricefx.atlassian.net/browse/PFPCS-3489
https://pricefx.atlassian.net/browse/PFPCS-3438
https://pricefx.atlassian.net/browse/PFPCS-3410
https://pricefx.atlassian.net/browse/PFPCS-3355
https://pricefx.atlassian.net/browse/PFPCS-3338
https://pricefx.atlassian.net/browse/PFPCS-3280
https://pricefx.atlassian.net/browse/PFPCS-3256
https://pricefx.atlassian.net/browse/PFPCS-3256
https://pricefx.atlassian.net/browse/PFPCS-3177
https://pricefx.atlassian.net/browse/PFPCS-3053
https://pricefx.atlassian.net/browse/PFPCS-3699
https://pricefx.atlassian.net/browse/PFPCS-3386
https://pricefx.atlassian.net/browse/PFPCS-4284
https://pricefx.atlassian.net/browse/PFPCS-3003
https://pricefx.atlassian.net/browse/PFPCS-3086

[PFPCS-3137] - [Detail View] > Customer Summary > Remove "YTD" in Total revenue/margin/volume
[PFPCS-3140] - [Portfolio] > Chart > Pricing Opportunity by Product Type > Tooltip> Not show % value
[PFPCS-3142] - [Detail View] > Waterfall > Not show data like SIP

[PFPCS-3157] - [Portfolio] > Table: Selling Opportunity > Column: Opportunity > Not show value
[PFPCS-3172] - [Customer Product Portfolio]Error in Tooltip of Revenue And Margin Contribution chart
[PFPCS-3213] - Detail View > Customer Summary > Segment does not display

[PFPCS-3232] - Global View > Pie charts > Avg. Margin % is incorrect

Tasks

[PFPCS-3013] - Update document for new version 1.3

[PFPCS-3059] - Create generator for process of table

[PFPCS-3077] - Group some constants in library

[PFPCS-3094] - [CID] Remove some unused variables and methods

[PFPCS-3096] - [Product Portfolio] > Tables: Selling Opportunity & Pricing Opportunity > Show top
products

[PFPCS-3104] - [CID] Rename function DataTable.setTopWorstData to DataTable.setData
[PFPCS-3124] - [Customer Global View] update URL in CustomerSummary portlet get from constant
[PFPCS-3126] - [CID] move some string to Constant

[PFPCS-3127] - [CID] Update some variable names

[PFPCS-3193] - [CID] add “setup Simulation” step into deployment Script

[PFPCS-3201] - Add Unity preferences from QA to package

[PFPCS-3225] - [Customer Global View] Change color setting from Constant of SIP to Dashboard of CID

Improvements

[PFPCS-2769] - Refactor code base on Code review

[PFPCS-2876] - [Customer Detail View] Data of Waterfall chart should be queried from DM, not query
from Simulation

[PFPCS-2878] - Update currency code and symbol in Chart

[PFPCS-3012] - [Customer Product Portfolio] Update/refactor chart “Revenue And Margin Contribution”

"_n

® [PFPCS-3215] - Detail View, Portfolio > Customer Summary > Remove “s” in label “Customers”

Stories

® [PFPCS-3006] - Consistency for values in Average Invoice Price table

Customer Insights Dashboard 1.2
New Features

® [PFPCS-2766] - [Customer Global View] Add more Customer Summary portlet
® [PFPCS-2767] - [Customer Product Portfolio] Add Customer Summary portlet

Improvement
® [PFPCS-2930] - [Customer Detail View] Change the summary portlet
Bugs

® [PFPCS-2908] - [Detail View_Summary] Category row should be hidden if no value selected
® [PFPCS-2912] - [Customer Summary portlet]_Trend symbol is incorrect
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https://pricefx.atlassian.net/browse/PFPCS-3201
https://pricefx.atlassian.net/browse/PFPCS-3225
https://pricefx.atlassian.net/browse/PFPCS-2769
https://pricefx.atlassian.net/browse/PFPCS-2876
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https://pricefx.atlassian.net/browse/PFPCS-2766
https://pricefx.atlassian.net/browse/PFPCS-2767
https://pricefx.atlassian.net/browse/PFPCS-2930
https://pricefx.atlassian.net/browse/PFPCS-2908
https://pricefx.atlassian.net/browse/PFPCS-2912

® [PFPCS-2972] - [Customer Product Portfolio] Total Revenue/Margin/Volume in Summary portlet should
be calculated based on time filter

Customer Insights Dashboard 1.1
Bugs

® [PFPCS-2722] - [Chart Pricing Opportunity by Product Attribute]_No spacing between words
® [PFPCS-2729] - Trend L12M is inaccurately for those products that data exists in just one quarter
® [PFPCS-2744] - [CID] Hotfix Preferences for Customer Insights Dashboards on Unity mode

Tasks

® [PFPCS-2564] - Write document for CIDs Introduction
® [PFPCS-2742] - [CID] Do release activities for version 1.1.0

Improvements

[PFPCS-2568] - Customer Summary _Not display null/zero when no data exist

[PFPCS-2569] - Update list value in Category in dashboard input

[PFPCS-2574] - Support change label of some params configured in PP

[PFPCS-2590] - Rename column “Field Name” in PP
"PFXTemplate_Customerinsights_Customer_Segment” to "Source Field”

[PFPCS-2610] - Customer Summary portlet_ Little updates

[PFPCS-2634] - [Customer Global View] add click-through from the Trends table

[PFPCS-2643] - Update: using sourceField to match data between Product master and Product
datasource

[PFPCS-2652] - Update some points in charts and table

[PFPCS-2656] - Update The Health Score calculation

[PFPCS-2689] - [Simulation] Support multi order type of classification ranges

[PFPCS-2708] - [dashboard] Using constants defined in library

[PFPCS-2709] - [Customer Detail View] Should round before pass value to function api.formatNumber
[PFPCS-2713] - [Customer Product Portfolio] Product Attribute should show label Translations
[PFPCS-2715] - Should use key label in configuration PP to show in KPI dropdown list
[PFPCS-2716] - Should use key label in configuration PP to show in Timefilter dropdown list
[PFPCS-2726] - CID update default Preferences for dashboards

Customer Insights Dashboard 1.0
New Features

[PFPCS-1717] - Potential by Product Attribute

[PFPCS-2328] - Open a new dashboard in a new web browser tab

[PFPCS-2400] - [Customer Product Portfolio]_Adding Product Health Score

[PFPCS-2402] - [Customer Product Portfolio]_ new table: Cross-Sell and Up-Sell Opportunity
[PFPCS-2445] - [Customer Global View]_ new table: Cross-Sell and Up-Sell Opportunity

Stories

® [PFPCS-16] - Customer Insight Dashboard
® [PFPCS-419] - Aggregated Datamart for YTD data
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[PFPCS-689] - Documentation - Aggregated Datamart

[PFPCS-690] - Documentation - Dashboard Configuration

[PFPCS-1203] - Data Pre-processing

[PFPCS-1204] - Customer Insights - Customer Details

[PFPCS-1306] - Update Customer Revenue And Margin Trend Last 12M & Projection chart
[PFPCS-1370] - Customer Insights - Global View

[PFPCS-1418] - Customer Insights - Customer Products Portfolio

Tasks

[PFPCS-1075] - Manage Sonar bugs and code smells on Customer Insights

[PFPCS-1113] - Update Product DM in QA partition

[PFPCS-1117] - Update Sales standard data DS in QA partition

[PFPCS-1718] - Trend symbols

[PFPCS-1743] - Adjust [End date] for time filters

[PFPCS-1812] - Upload new data in 2020

[PFPCS-1837] - Should check null value in operator of DashboardUtils element in Customer Detail View
[PFPCS-2030] - Create guideline how to configure Customer Insights Dashboard
[PFPCS-2365] - Setup autopublishing for CID package

[PFPCS-2395] - Create document for CIDs introduction

[PFPCS-2536] - [CID] Create deployment script

[PFPCS-2539] - [Portfolio] Pricing Opportunity by Worst Products should be hidden by default
[PFPCS-2558] - Fix release package-remove gitignore

Improvements

[PFPCS-1032] - Code Improvement from Sonar

[PFPCS-1067] - Show customer Id, customer name under the title of embedded dashboard
[PFPCS-1194] - Double bar graph in embedded charts

[PFPCS-1432] - Rename label “"FieldName” to "Dimension Filter”

[PFPCS-1451] - Consistent Start and End Date for processing

[PFPCS-1490] - Consistent name for portlet header and chart

[PFPCS-1509] - Change configuration.RevenueFieldName to configuration.InvoicePriceFieldName
[PFPCS-1518] - Display percentage for trend value L12M

[PFPCS-1526] - Move calculation for potential to Simulation logic

[PFPCS-1527] - Update logic to get Potential for Global View dashboard

[PFPCS-1558] - Refactor element “GetTopCustomers” of Customer Global view
[PFPCS-1565] - Fix some sonar bugs in customer detail view dashboard

[PFPCS-1578] - Move some common inputs to libs

[PFPCS-1627] - Fix some sonar bugs

[PFPCS-1633] - Adding Unknown field to Cross Selling Opportunity table (Portfolio)
[PFPCS-1683] - Classes into Data Filter (Category)

[PFPCS-1726] - Product attributes input should get dimension attributes

[PFPCS-1727] - Rename “Buying Frequency” to "Number of transactions” in all dashboard
[PFPCS-1731] - Should set sortBy and list of attributes in function api.stream
[PFPCS-1805] - Formatting label

[PFPCS-1811] - Update waterfall chart structure from AP setting

[PFPCS-1842] - Tooltips improvement - Revenue and margin trends & projections chart
[PFPCS-1847] - Change solution from memoryDB to non-memoryDB

[PFPCS-1907] - Correct value on Opportunity table of Portfolio dashboard

[PFPCS-1916] - Just show max 100% in axis of chart

[PFPCS-1917] - In Dimension filter, if change value of “"Category” field, old value of “Value” field should
be reset to null/empty
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[PFPCS-1979] - Hiding 0 value in table Potential by Product Attribute

[PFPCS-1992] - Change arrow to fix problem on Unity and visible dashboard input items in portlet
selection

[PFPCS-2019] - Remove items as: ROWID and Scenario in Dimension Filter - Category
[PFPCS-2020] - Show “"no data” in case no customer is selected

[PFPCS-2021] - Customer Detail View - Customer Revenue and Margin Trend & Projection - Change
labels

[PFPCS-2022] - Global View - Pricing Opportunity: Change color for top/worst group
[PFPCS-2023] - Customer Detail View - Number Of Transaction Trend & Projection - Change labels
[PFPCS-2025] - Set display mode is ‘Never’ for some elements in Simulation logic

[PFPCS-2042] - Regression line should be a line in chart

[PFPCS-2057] - Improve performance of simulation logic

[PFPCS-2058] - Improve performance of customer product portfolio dashboard

[PFPCS-2076] - Improve performance of some elements in simulation logic

[PFPCS-2221] - Add Customer Segment to Simulation

[PFPCS-2237] - Customer Global View: Merge other metric process to SQL (in the same with X-sell/Up-
sell/RevenueBelowTarget

[PFPCS-2264] - Support multitype source to get customer segment

[PFPCS-2282] - [Customer Product Portfolio] Update list value of Product attribute in Potential By
Product Attribute table match with Opportunity table

[PFPCS-2286] - [Customer Global View] Remove Sorted element

[PFPCS-2288] - Update Ul_Revenue and Margin Contribution chart

[PFPCS-2305] - [Customer Product Portfolio] Should use api.local to pass return value in element
“GetDataForPotentialPerProductAttribute”

[PFPCS-2318] - [Customer Product Portfolio] Update logic of element
GetTopAveragelnvoicePriceByCustomerClassData to improve performance

[PFPCS-2456] - [Simulation] refactor simulation logic

[PFPCS-2500] - Change format number in charts and tables

[PFPCS-2501] - Update label and default value of DataFilter

[PFPCS-2502] - [Customer Global View] Pricing Opportunity and Opportunity table - Just show the
WORST customers

[PFPCS-2503] - [Customer Detail View] View some value on click-through portlet

[PFPCS-2508] - [Customer Detail View] Update regression value in charts

[PFPCS-2512] - [Customer Detail View] - Customer Summary portlet- Adding more info
[PFPCS-2513] - [Portfolio] - Revenue Below Target by Product Group chart - change name to Pricing
Opportunity by Product Group.

[PFPCS-2514] - [Global View and Portfolio] - the Health tables: all the Last 12 M and YTD trends will be
in removed from Health table and moved to a new table Trends.

[PFPCS-2515] - [Simulation] Customer Segment- adding separator in between the particular items
[PFPCS-2519] - [Portfolio] - rename “"Revenue Below Target” to “Pricing Opportunity”
[PFPCS-2528] - [Customer Detail View] - Customer Summary portlet- Adding more info
[PFPCS-2529] - Opportunity tables in Global and Portfolio - Please rename to Selling Opportunity

Sub-tasks

[PFPCS-672] - Embedded Waterfall Chart

[PFPCS-681] - Embedded Breakdown Revenue Chart

[PFPCS-682] - Embedded Revenue and Margin Chart

[PFPCS-693] - Reporting hierarchy configurable

[PFPCS-694] - Customer health score Calculation

[PFPCS-695] - Buying Frequency Calculation

[PFPCS-713] - Create TDD4C for Embedded Waterfall Chart

[PFPCS-824] - Adding label to show the chosen Customer ID or Product Group in all Charts
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[PFPCS-887] - Cross Selling Opportunity

[PFPCS-944] - Adding Waterfall chart with percentage value

[PFPCS-1109] - Set up Simulation to run automatically

[PFPCS-1136] - Adding message to the chart when no data exist

[PFPCS-1137] - Update attribute in PP Report Hierarchy to define the element we want to disable
[PFPCS-1154] - Comparing data between periods

[PFPCS-1176] - Rename element and method to Customerinsights instead of Customerlnsight
[PFPCS-1189] - Adding Volume trend into Customer Health Score

[PFPCS-1374] - Add Pricing Opportunity table as old DB

[PFPCS-1375] - Apply Dashboard Library into this dashboard

[PFPCS-1389] - Add more item in time filter ‘last 12 months’ to compare with 12 months before
[PFPCS-1408] - Apply Dashboard libs to existed chart in Customer Detail View

[PFPCS-1409] - Add Revenue Breakdown to customer Detail View

[PFPCS-1410] - Add Waterfall Chart to customer Detail View

[PFPCS-1411] - Add Revenue and Margin per Quarter to Customer Detail View

[PFPCS-1421] - Add more 2 items in time filter

[PFPCS-1422] - Add Pricing Potential table

[PFPCS-1425] - Update logic classification for customer base on new update

[PFPCS-1452] - Refactor code for Customer Global View based on new structure data from Pre-Process
[PFPCS-1463] - Calculate Trend L12M based on dynamic months

[PFPCS-1475] - Update charts based on new changes of Highchart libs

[PFPCS-1478] - Add Cross Selling Opportunity Table

[PFPCS-1479] - Add Average Invoice Price table

[PFPCS-1480] - Add Potential per product type Table

[PFPCS-1481] - Add Potential per product table

[PFPCS-1482] - Add Bar & line chart showing Potential

[PFPCS-1483] - Add Customer Dashboard Portfolio Dashboard Inputs

[PFPCS-1535] - Add Pie chart showing sum of Potential and % of Total Potential per product type
[PFPCS-1588] - Set default value for List of Product Attribute is "Product Group”

[PFPCS-1628] - Add if statement braces

[PFPCS-1629] - Add type for Constant in Customerlnsights.Constant

[PFPCS-1699] - Revenue and Margin Contribution chart

[PFPCS-1830] - Update Calculation of Customer Health Score

[PFPCS-1831] - Update calculation of Revenue/Margin/Volume trend last 12M

[PFPCS-1832] - Add calculation of Revenue, Margin and Volume trend YTD

[PFPCS-1833] - Update calculation of Cross-Sell Opportunity - Global View

[PFPCS-1834] - Update calculation of Revenue below target

[PFPCS-1840] - Calculation for Cross-Sell Opportunity - Customer Product Portfolio

[PFPCS-1846] - Up-sell will be part of the Cross Selling Opportunity table which will be renamed to
Opportunity

[PFPCS-1936] - Change solution from memoryDB to non-memoryDB In Simulation logic
[PFPCS-1937] - Change solution from memoryDB to non-memoryDB In Customer Global View
Dashboard

[PFPCS-1938] - Change solution from memoryDB to non-memoryDB For Revenue Breakdown chart In
Customer DetailView Dashboard

[PFPCS-2284] - Add more Customerld parameter for some functions

[PFPCS-2406] - Change Revenue Below Target = Potential calculation

[PFPCS-2407] - Change % Revenue Below Target calculation

[PFPCS-2408] - Change Pricing Opportunity table

[PFPCS-2416] - Add Product Health Score into Simulation
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Change Requests

[PFPCS-1685] - Top/worst sorting not working properly

[PFPCS-1652] - Add Margin to the Customer Revenue Trend and Projection chart

[PFPCS-1693] - Average Invoice price per the relevant customer into Average Invoice Price table
[PFPCS-1714] - Merge Customer Health Score table with Customer Insight Summary table
[PFPCS-1715] - Potential By Product table - new columns and rename

[PFPCS-1778] - Calculations updates

[PFPCS-1781] - Linear trends & projections - seasonality adjustment

[PFPCS-2124] - Update Cross Sell calculation

[PFPCS-2326] - [Customer Product Portfolio]- Rename Opportunity table

[PFPCS-2327] - [Customer Product Portfolio] - Product Health Summary table - revert top/worst
[PFPCS-2401] - Update formulas for % Revenue Below Target

[PFPCS-2404] - [Customer Product Portfolio]_Remove some Potential portlets

[PFPCS-2405] - [Customer Product Portfolio]_ Change Pricing Opportunity table and Revenue below
target

[PFPCS-2424] - [Customer Global View]_ Change location click through “ to Product Portfolio”
[PFPCS-2429] - [Portfolio] Change "Potential” to “Revenue Below Target” for 2 charts: "Potential
Worst Products Chart” and “Potential Tops Products Chart”

[PFPCS-2446] - [Customer Global View]_ Change Revenue below target

[PFPCS-2447] - [Customer Global View]_ remove fields in Pricing Opportunity table
[PFPCS-2448] - [Customer Global View]_remove table Pricing Potential

Bugs

[PFPCS-796] - Customer Insight Summary: % Margin is not calculated exactly
[PFPCS-806] - Error (@13) cannot get property “ProductMapCurrentime” on null object when Time
Dimension = MTD or QTD

[PFPCS-808] - Error (@74) occurs when choosing a single Customer ID
[PFPCS-829] - Incorrect cross-sell calculation

[PFPCS-834] - Customer ID does not display with revenue = 0

[PFPCS-835] - Export data in Unity Ul does not keep filtering for country
[PFPCS-865] - Buying frequency is incorrect

[PFPCS-888] - Margin trend last 12M is incorrect

[PFPCS-889] - Revenue trend last 12M is incorrect

[PFPCS-901] - Missing trend arrow

[PFPCS-902] - Error on clicking Customer ID has no data

[PFPCS-1065] - Error (@76) for PricingOpportunityAnalyst

[PFPCS-1066] - Error(@0) for CustomerHealthScoreAnalyst

[PFPCS-1112] - Incorrect Product Group in Cross Selling Opportunity
[PFPCS-1114] - Revenue and Margin % chart show wrong value and month format
[PFPCS-1147] - Incorrect Price Opportunity

[PFPCS-1153] - Customer Health Score does not show with an input Customer ID
[PFPCS-1170] - Excel format is incorrect at fields have trending arrow
[PFPCS-1181] - Error (@0) when opening the dashboard

[PFPCS-1188] - Misspelled name in Waterfall chart

[PFPCS-1423] - Cross Sell Opportunity is not calculated (Global View)
[PFPCS-1440] - Counting for Customer classification (per Revenue) is incorrect
[PFPCS-1484] - Edit chart label (Global View)

[PFPCS-1485] - Error (@63) occurs when no data exists in Detail View
[PFPCS-1488] - Customer (s) filter does not work (Global View)

[PFPCS-1519] - Inconsistent name chart in Detail view


https://pricefx.atlassian.net/browse/PFPCS-1685
https://pricefx.atlassian.net/browse/PFPCS-1692
https://pricefx.atlassian.net/browse/PFPCS-1693
https://pricefx.atlassian.net/browse/PFPCS-1714
https://pricefx.atlassian.net/browse/PFPCS-1715
https://pricefx.atlassian.net/browse/PFPCS-1778
https://pricefx.atlassian.net/browse/PFPCS-1781
https://pricefx.atlassian.net/browse/PFPCS-2124
https://pricefx.atlassian.net/browse/PFPCS-2326
https://pricefx.atlassian.net/browse/PFPCS-2327
https://pricefx.atlassian.net/browse/PFPCS-2401
https://pricefx.atlassian.net/browse/PFPCS-2404
https://pricefx.atlassian.net/browse/PFPCS-2405
https://pricefx.atlassian.net/browse/PFPCS-2424
https://pricefx.atlassian.net/browse/PFPCS-2429
https://pricefx.atlassian.net/browse/PFPCS-2446
https://pricefx.atlassian.net/browse/PFPCS-2447
https://pricefx.atlassian.net/browse/PFPCS-2448
https://pricefx.atlassian.net/browse/PFPCS-796
https://pricefx.atlassian.net/browse/PFPCS-806
https://pricefx.atlassian.net/browse/PFPCS-808
https://pricefx.atlassian.net/browse/PFPCS-829
https://pricefx.atlassian.net/browse/PFPCS-834
https://pricefx.atlassian.net/browse/PFPCS-835
https://pricefx.atlassian.net/browse/PFPCS-865
https://pricefx.atlassian.net/browse/PFPCS-888
https://pricefx.atlassian.net/browse/PFPCS-889
https://pricefx.atlassian.net/browse/PFPCS-901
https://pricefx.atlassian.net/browse/PFPCS-902
https://pricefx.atlassian.net/browse/PFPCS-1065
https://pricefx.atlassian.net/browse/PFPCS-1066
https://pricefx.atlassian.net/browse/PFPCS-1112
https://pricefx.atlassian.net/browse/PFPCS-1114
https://pricefx.atlassian.net/browse/PFPCS-1147
https://pricefx.atlassian.net/browse/PFPCS-1153
https://pricefx.atlassian.net/browse/PFPCS-1170
https://pricefx.atlassian.net/browse/PFPCS-1181
https://pricefx.atlassian.net/browse/PFPCS-1188
https://pricefx.atlassian.net/browse/PFPCS-1423
https://pricefx.atlassian.net/browse/PFPCS-1440
https://pricefx.atlassian.net/browse/PFPCS-1484
https://pricefx.atlassian.net/browse/PFPCS-1485
https://pricefx.atlassian.net/browse/PFPCS-1488
https://pricefx.atlassian.net/browse/PFPCS-1519
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[PFPCS-1547] - Trend charts display incorrect (Detail View)

[PFPCS-1549] - Category filter runs incorrect (Detail View)

[PFPCS-1570] - Incorrect calculation in Revenue Breakdown chart

[PFPCS-1589] - Error (@621) Ambiguous method overloading (Detail View)

[PFPCS-1594] - Local Adjustment does not show detail in waterfall chart

[PFPCS-1607] - Error when removing default or leaving blank in Time Filter

[PFPCS-1622] - Some fields in Cross Sell Opportunity table are incorrect (Product Portfolio)
[PFPCS-1678] - Check Zero when calculation AvgPrice in function Classification.calculateAvgPrice
[PFPCS-1725] - Should check null in some functions of Customerlnsights libs

[PFPCS-1744] - Ranking is incorrect by KPI = Health Score (Global view)

[PFPCS-1818] - Filter MTD and QTD do not work in Product Portfolio DB

[PFPCS-1946] - [Product Portfolio]_ Product Trend YTD is incorrect when no customer selected
[PFPCS-1998] - Global View_Customer input should not affect to calculation

[PFPCS-2002] - Average Revenue segment should be calculated on Customer Revenue
[PFPCS-2009] - % Product Buying_ total of traded products should be changed by Category filter
[PFPCS-2247] - Customer Product Portfolio dashboard - chart "Revenue And Margin Contribution”
show null in drilldown

[PFPCS-2271] - Portfolio_Cross Sell only shows for products bought (not bought is not shown)
[PFPCS-2287] - [Customer Product Portfolio] There is an error as attached picture

[PFPCS-2439] - Health score should get decimal or rounding

[PFPCS-2458] - [Portfolio] doesn't show “"Revenue Below Target By Product Type” chart for some case
[PFPCS-2461] - [Customer Global View] Pricing Opportunity table, if the Revenue below Target =0
then % Revenue below Target should be 0%.

[PFPCS-2467] - [Portfolio] Update formulas for Average Invoice Price = Average Unit Invoice Price for
the particular Product ID and particular Customer Segment

® [PFPCS-2489] - [Global View]_ % Product Buying is incorrect
® [PFPCS-2492] - [Portfolio]_Top/Worst Products in chart should be ranked like Top/Worst Customers in

Global View

® [PFPCS-2521] - [Detail View] _Remove “per Day” in chart for Transactions trend last 12M
® [PFPCS-2530] - Trend arrow displays incorrectly
® [PFPCS-2565] - [Detail View]_Error (@282) when no data to display


https://pricefx.atlassian.net/browse/PFPCS-1547
https://pricefx.atlassian.net/browse/PFPCS-1549
https://pricefx.atlassian.net/browse/PFPCS-1570
https://pricefx.atlassian.net/browse/PFPCS-1589
https://pricefx.atlassian.net/browse/PFPCS-1594
https://pricefx.atlassian.net/browse/PFPCS-1607
https://pricefx.atlassian.net/browse/PFPCS-1622
https://pricefx.atlassian.net/browse/PFPCS-1678
https://pricefx.atlassian.net/browse/PFPCS-1725
https://pricefx.atlassian.net/browse/PFPCS-1744
https://pricefx.atlassian.net/browse/PFPCS-1818
https://pricefx.atlassian.net/browse/PFPCS-1946
https://pricefx.atlassian.net/browse/PFPCS-1998
https://pricefx.atlassian.net/browse/PFPCS-2002
https://pricefx.atlassian.net/browse/PFPCS-2009
https://pricefx.atlassian.net/browse/PFPCS-2247
https://pricefx.atlassian.net/browse/PFPCS-2271
https://pricefx.atlassian.net/browse/PFPCS-2287
https://pricefx.atlassian.net/browse/PFPCS-2439
https://pricefx.atlassian.net/browse/PFPCS-2458
https://pricefx.atlassian.net/browse/PFPCS-2461
https://pricefx.atlassian.net/browse/PFPCS-2467
https://pricefx.atlassian.net/browse/PFPCS-2489
https://pricefx.atlassian.net/browse/PFPCS-2492
https://pricefx.atlassian.net/browse/PFPCS-2521
https://pricefx.atlassian.net/browse/PFPCS-2530
https://pricefx.atlassian.net/browse/PFPCS-2565
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